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1 Introduction

The Finite Difference Time Domain (FDTD) method of electromagnetic calculation is
widely used in a variety of electromagnetic radiation, interaction, and scattering
applications.  The method is a transient marching-in-time approach, in which time is
divided into small discrete steps and the electric and magnetic fields on a fine grid are
calculated at each step.  Although a discussion of the fundamentals of the FDTD
method is beyond the scope of this manual, The Finite Difference Time Domain Method
for Electromagnetics, by Kunz and Luebbers [1] provides an in-depth exploration of the
method and offers many example results.  To obtain reliable and accurate results from
the XFDTD program, a familiarity with the basic FDTD method is essential.  In addition,
a working knowledge of either the Unix operating system or Windows NT/95™ is
required.

1-1 Operating System

The FDTD method is very general in terms of geometries and materials that can be
considered.  However, even for general problems, such as resonant frequency
simulations where the geometry extent is several wavelengths, the program requires
the capabilities of a workstation or powerful PC.  XFDTD 5.0 is available for Windows
NT and Windows 95/98 operating systems.  As with previous version of XFDTD,
Version 5.0 is also available fore Silicon Graphics, IBM RISC, Hewlett-Packard, Sun
Solaris, DEC Digital Unix, SCO Unix, and Linux Unix operating systems. 

1-2 General Technique for FDTD Calculations

1-2-1  Define Geometry

To apply the FDTD method, the geometry of interest must be approximated as discrete
material cells.  Each cell edge may be defined with different dielectric properties. Since
XFDTD uses rectangular cells, the geometry is approximated using the edges,
surfaces, or entire volumes of small rectangular boxes.  The cell edges must be smaller
than approximately one-tenth of a wavelength for accurate results.  They must also be
small enough to approximate the important geometry features.  XFDTD provides
several methods for meshing the desired geometry such as:  

T importing an existing geometry file

T building the geometry from a library of basic objects including plates, cylinders,
spheres, and boxes  

T setting the cell edges manually in user-defined objects using the mouse
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1-2-2  Define Project Parameters 

Once the geometry is defined, the FDTD calculation parameters for the specific project
are chosen.  These parameters include the location and type of excitation.  For
example, the geometry may be excited by an incident plane wave for a scattering or
penetration problem, or by voltage and/or current sources connected to the geometry
for a microstrip or antenna radiation problem.  If a TEM cell is being considered,
XFDTD can provide the TEM wave excitation.  

The waveform must be chosen as either a transient pulse or sinusoid and the desired
output quantities selected.  The outputs can include far-zone fields in particular
directions (for a transient pulse excitation), near-zone field quantities at particular
points or in particular slices of the geometry, steady-state field magnitudes and many
more.  In addition, wide bandwidth impedance and S-Parameters versus frequency can
be computed with a transient pulse excitation.  Many other results are available, and
these are described in detail in this manual.

1-2-3  Results and Output

After the geometry and project parameters are defined and saved to files, the actual
FDTD calculations may be performed.  Depending on the number of cells in the FDTD
space and the number of time steps specified, the calculation may require from minutes
to hours to days.   All results can be viewed from within the XFDTD interface and some
further post-processing calculations may be done.   In addition, the FDTD calculation
output files, which are in plain ASCII format, are available for custom post-processing.

1-3 Summary of XFDTD Features

The features available in each version of XFDTD 5.0 are listed in the table attached
below.
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Feature XFDTD 5.0 XFDTD 5.0 Pro XFDTD 5.0 Bio-Pro

Lossy Dielectric Materials T T T 

Lossy Magnetic Materials T T T 

Perfect Conductor T T T

Frequency-Dependent Dielectrics T T T

Anisotropic Ferrites  T T

Display of geometry with
slice/translate/zoom

T T T

Interactive geometry editing with
mouse control

T T T

Local Regions of smaller cells  T T

Automatic meshing of basic shapes T T T

Copy regions of mesh T T T

Rotate mesh coordinates by 90
degrees

T T T

2D slices and 3D view of meshed
objects

T T T

Merge geometries together to
combine objects

T T T

Menu control of FDTD calculations T T T

Multiple Voltage Sources with
series resistor

T T T

Liao, PML, PEC,  and PMC outer
boundaries

T T T

Incident Plane Wave excitation T T T

Sample fields and currents versus
time

T T T

Line Plots of Results T T T

Color Display of 2D Field/current
slices

T T T

Color Display of 3D surface
currents

 T 
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Feature XFDTD 5.0 XFDTD 5.0 Pro XFDTD 5.0 Bio-Pro

‘ ‘Movie" sequences of steady-state
fields through geometry

T

‘ ‘Movie" sequences of transient
fields vs time

T T T 

Multiple Voltage/Current Sources
with Series/Parallel RLC

T T

Input Impedance vs Frequency T T T

Single Frequency Input Impedance T T T

Multi-Port S-Parameters vs
Frequency

 T T

Multi-Port steady state
S-Parameters

 T T

Specific Absorption Ratio  (SAR)   T

Display Planes of  steady-state E, B
fields

  T

Display Planes of steady-state
current density

  T

Adjust SAR level to specified input
power

  T

Calculate 1 and 10 gram SAR
averages

  T

Location of peak SAR   T

SAR ‘ ‘movies" by slicing through
the mesh

  T

TEM cell excitation   T 

Pre-Meshed human head and body   optional

Module for remeshing dielectric with
different cell sizes and/or rotation

  optional

Module for removing  mesh rotation
from  antenna patterns

  optional

Circular Polarization Antenna Gain
Patterns

T T T

Antenna Impedance vs Frequency T T T

Transient Far Zone Transformation T T T
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Feature XFDTD 5.0 XFDTD 5.0 Pro XFDTD 5.0 Bio-Pro

Steady State Antenna
Impedance/Efficiency

T T T

Antenna Gain vs Frequency T T T

Single Frequency Far Zone
Transformation

T T T

Linear Polarization Antenna Gain vs
Angle

T T T

Automatic Meshing of Spiral
Antennas

T T T

Thin Wires with different wire radii T T T

Incident Plane Wave T T T

Scattering Cross Sections vs
Frequency

T T T

Bi-Static Scattering vs Angle T T T
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2 Installation and Licensing

The installation and licensing procedure for XFDTD depends on what operating system
(Unix or Windows) you have and what version of XFDTD (permanent license or
evaluation license) you are installing.   There are detailed descriptions of the
installation procedure provided in two separate documents.    

� For evaluation versions of XFDTD, see the document demo_install.pdf.

� For permanent license installations (purchased versions of XFDTD) see the
document permanent_install.pdf.
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3  Estimating Computer Resource Requirements

This chapter discusses basic relationships for estimating computer resources required
for FDTD calculations.  The important aspects of entering the geometry and calculation
parameters are discussed.  Equations for estimating the amount of memory and
computer CPU time required for a typical FDTD calculation are provided.

3-1  Defining the Cell Size 

The starting point of an FDTD calculation is often deciding the spatial increment, or cell
size, of the structure being simulated.  The fundamental constraint on the cell size is 
that it must be much less than the smallest wavelength for which accurate results are
desired.  A commonly applied constraint is "ten cells per wavelength,” meaning that the
side of each cell ( x, y, z) should be 1/10  or less at the highest frequency (shortest
wavelength) of interest.  If the cell size is much larger than this, the Nyquist sampling
limit,  = 2 x, is approached too closely for reasonable results to be obtained. 
Significant aliasing is possible for signal components above the Nyquist limit.

Choosing a cell size of 1/10  is a good starting point, but other factors may require a
smaller cell size to be chosen.  This topic is covered in more detail later.

Note:  FDTD is a volumetric computational method.  If some portion of the
computational space is filled with penetrable material, the wavelength in the material
must be used to determine the maximum cell size.  Geometries containing electrically
dense materials require smaller cells than geometries that contain only free space and
perfect conductors.

3-1-1 Creating a Geometry with FDTD Cells

Before any FDTD calculation can be done, an accurate approximation of the structure
under test must be entered into XFDTD.   As was mentioned above, a resolution of
one-tenth of a wavelength is the minimum required for accurate FDTD results. 
However, many structures require a higher resolution due to various factors including
curved surfaces, wire radii, and small details of the structure.  An example might be a
microstrip circuit that has a small (<< ) separation distance between the ground plane
and the trace.  In this case, the driving factor on the cell size will probably be the
separation distance between the ground plane and trace rather than the highest
frequency of interest.

XFDTD uses a “staircase” method of approximating curved surfaces with rectangular
cubes.  If the structure contains curves, a higher number of cells per wavelength will be
required to reduce the error from the staircased approximation.  The exact resolution
required will vary, but a good starting point is between 20 and 30 cells per wavelength.
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XFDTD has a feature known as “subgridding” for approximating small regions of the
structure at a higher resolution.   The subgrid can have a resolution of either one-third
or one-fifth the cell size and is useful in situations where only a small part of the
structure requires the higher resolution for producing an accurate approximation. 
Subgrids are described in more detail in a later chapter.

3-1-2 Free Space Boundaries

Typically XFDTD makes use of a free space, or absorbing, outer boundary.  A number
of cells must separate the structure from this outer boundary to allow better absorption
of the fields.  The minimum spacing between the geometry and outer boundary is ten
cells, although fifteen or more is sometimes required for accurate results.  If extremely
small cells (relative to the wavelength) are used, an outer boundary of approximately
1/3 of a wavelength at the lowest frequency of interest should be used, if possible.

3-2  Determining the Total Number of Cells

Once the cell size has been chosen, the total number of cells needed for the
calculation can be found.   The number of cells in the x, y, and z directions, often called
NX, NY, and NZ, is determined from the sum of free space boundary cells and the
dimensions of the structure in each direction divided by the cell size.   The total size of
the FDTD space in cells is determined by the product of the cells in each dimension. 
The memory requirements of XFDTD are directly related to the number of cells in the
calculation space.  A computer with 128 MB of memory can accommodate calculations
involving up to three million cells. 

3-3  Estimating the Necessary Computer Resources 

This section discusses the computer resources required for a given calculation. Let the
total number of cells in the problem space be designated as NC=NX * NY * NZ.  If
subgrids are being used, their cells must also be added to the cells in the main grid to
give a total cell number NC.  The material information is stored in 2 byte integer arrays
on most computers (some require 4 byte integers).  Assume that both dielectric and
magnetic materials are included. Then, to estimate the computer storage in bytes
required the following relationship can be used:

storage ' NC × 6
fields

cell

× 4
bytes

field

% 6
materials

cell

× 2
bytes

material

Note:  If no magnetic materials are present and the magnetic grid has not been
defined, the factor of six multiplying the materials/cell factor is reduced to three.
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This equation neglects the relatively small number of auxiliary variables needed by  the
program.  It also neglects the memory needed to store the executable instructions. 
Since this overhead is nearly independent of the number of cells in the problem space,
as the total number of cells increases it will become a smaller fraction of the total
memory required.  However, if the computer memory storage as computed above,
exceeds the memory capacity of the computer, then fewer FDTD cells must be
used.  

This estimate will be low if many far-zone field directions are specified with transient
calculations, especially if the calculation has a large number of time steps.  For each
far-zone direction the program will require six floating-point (4-byte) arrays with a single
array index slightly larger than the number of time steps specified.  This additional
storage can be easily estimated and added to the above.  

For a (100 cell)3  problem space,  approximately 30 MBytes of memory would be
required, with the actual amount being somewhat greater due to storage of other
variables and instructions plus memory needed by the operating system.  Problems of
this size can be run on machines ranging from super computers to 32-bit personal
computers.  As available memory is reduced, the maximum number of cells which can
be accommodated is correspondingly decreased.  With 16 MBytes of memory, the
problem space size would be estimated from the above relationship as (79 cells)3.  

Note:  In actual experience 16 MBytes will accommodate approximately (72 cells)3,
indicating a memory overhead for instructions and auxiliary variables for this problem
size of about 30% of the memory needed to store the field components.  Again, for
larger problem spaces with more cells, this overhead percentage would be reduced.  

3-3-1  Far-Zone Radiation angles at a single frequency

The steady-state calculation option and its associated steady-state far-zone
transformation allow for unlimited far-zone calculations in post-processing.  With this
option the complex tangential fields on a closed surface surrounding the radiating
structure are determined at the end of the FDTD calculation.  These tangential fields
are then used by XFDTD to obtain far-zone radiation gain (or bistatic scattering) in any
direction during post-processing.  This eliminates the time and memory required for
many transient far-zone radiation directions.  However, this method provides results
only at the frequency of the input.

3-3-2 Execution Time Estimation

Another way to estimate the computational cost is by calculating the number of floating-
point operations required.  This method involves estimating the total number of time
steps to be calculated.  As a preliminary estimate, the time required for energy traveling
at the speed of light to traverse the geometry five times may be used.   With a transient
input, convergence of the calculation can be determined by observing the feed-point
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Figure 1  Coordinate system used in XFDTD

voltage and current or some other near-zone value.    With a steady-state input, near-
zone values in the space should be saved and observed to ensure the calculation has
reach steady-state.  This is especially important in calculations involving large amounts
of dielectric material where fields propagate more slowly.  Lossy geometries typically
will require fewer time steps while resonant geometries will require more.  With NC
representing the total number of cells and with the total number of time steps
designated as N, the total number of floating-point operations is estimated by: 

Operations ' NC × 80 operations / cell / time step × N

The actual number of calculations for each component depends on the material type
and excitation of the incident field at a particular time step.  There are also logical
statements which must be executed to determine what type of material (free space,
perfect conductor, dielectric) is located in a particular cell.  

The number of seconds required for a calculation can be estimated by dividing
the Operations given by the above equation by the FLOPS rating of your
computer.

Speeds of available machines range from 120 or more MFLOPS (Million Floating-point
Operations Per Second) for a fast workstation through 10 to 80 MFLOPS for typical
workstations. (Keep in mind that manufacturer’s ratings are often inflated, with a
realistic speed usually being less than half of that claimed.)  The run (CPU) time for a
(65 cell)3 problem containing about 1/4 million cells which requires 1000 time steps, or
approximately 22 x 109 floating-point operations, would be estimated as 3.7 minutes for
a 100 MFLOPS workstation and 30 minutes for a 14 MFLOPS workstation.



16

3-4 Coordinate System

The coordinate system used in XFDTD is shown in Figure 1.  Geometries are
described in Cartesian X, Y, Z coordinates.  Distances may be measured in spatial
increments x, y, z, with integer indices I, J, K locating points in the FDTD space as
x=I x. etc.  Far-zone directions are measured using spherical coordinates  and . 
For far-zone field amplitude calculations the far-zone distance is normalized to 1 meter.
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4  XFDTD Graphical User Interface

XFDTD is a graphical user interface to an FDTD calculation program.   With XFDTD 
electromagnetic simulations can be performed quickly and easily.  From within XFDTD
the object under consideration can be entered with the editing tools, the calculation
parameters for the input and output selected using informative menus, and the results 
displayed in a variety of formats.  This chapter of the manual contains an overview of
the entire interface.  More detailed descriptions of the menu options are found in other
chapters.

NOTE: The Windows NT/95/98 version of XFDTD and the UNIX version of XFDTD
have slightly different formats.  Whenever important differences exist between the
versions, mention will be made.  The term “windows version” will refer to the Windows
NT/95/98 version of XFDTD while “UNIX version” will refer to XFDTD for any UNIX
platform. 

4-1 Starting XFDTD

4-1-1 Starting XFDTD in Windows NT/95/98

In Windows NT or Windows 95/98, go to the Start Menu, select Programs, then
REMCOM, and finally XFDTD 5.0.

4-1-2 Starting XFDTD in UNIX

To start XFDTD from a Unix installation, enter the command "xfdtd504”.  Remember,
the XFDTD program files xfdtd504, calcfdtd504, xpostp50, and xpostpss50 must be
in the PATH or in the current directory and all files must have execute permission.  It is
best to make separate directories for each calculation.  Consequently, it is best to start
XFDTD from the desired output directory.  

4-2 The XFDTD User Interface

Figure 2 below shows XFDTD running in Windows NT with an example geometry and
project file already loaded.  A similar window for the UNIX version of XFDTD is shown
in a later figure.  Initially the XFDTD main window will be empty with just the menu bar 
across the top.  When a project file is loaded, both the geometry and the calculation
parameters are loaded and displayed on the screen.  The important features of the
XFDTD window are listed below. 

1.  Title Bar – across the top.  This contains the name of the window and is colored
(shown in blue in the figure) when the window is active.
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Figure 2: XFDTD window as seen on a Windows NT/95/98 computer.

Figure 3: The Tool Bar in XFDTD 5.0

2.  Menu Bar – pulldown menus for File, Edit, View, Window when viewing the
geometry file.  When viewing the Run Parameters window the “Results” entry is also
added.  The menu bar on the UNIX version of XFDTD will always display all the options
as there are not separate windows for Geometry and Run Parameters.

4.  Tool Bar – a row of icons which provide one-touch operation of frequently used
functions (Figure 3).  Pop-up balloons describe each button when the pointer is above
the button.  If a particular function is not available the button is disabled.  For example,
if no geometry is active for editing, the “edit geometry” button will be disabled.

5.  Main Grid (WINDOWS VERSION) – The Main Grid Window displays the actual
problem space.  When more than one geometry is open, the additional windows are
visible with the title “Sub Grid #1:” and so on.  Also in this case, an extra window
containing “All Grids” is open.  This window shows the main grid and the subgrids
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together.  Each of these windows allows selection of the  viewing plane and provides
specific tools by which to manipulate the geometry.  Note that editing is disabled in the
“All Grids” window.  When any one of these windows is active, features such as the
background grid, the electric or magnetic components, and normal elements can be
turned on and off.  Also, the zoom and slice features are functional.  Select the
coordinate plane in which to view the geometry by clicking on one of the three panes
along the left side of the window.  For each window, except the “All Grids” window, the
3D View is available displaying the entire problem space in three dimensions.

Panning in XY, YZ, and XZ planes in Windows 

If the Geometry window is active, the current coordinate system of the geometry is 
shown in blue along the left-hand side of the window.  When the mouse pointer is
moved over these panes, a hand icon appears.  By holding down the left mouse button
while the cursor is over a coordinate system window, the hand “grabs” the window and
allows panning of the viewed portion of the geometry to center features of interest. 
Furthermore, each coordinate plane zooms independently of the others.

Other controls of the geometry window

The zoom button increases or decreases the scale of the geometry
drawn in the window.  By pressing the magnifying glass at the left of the
zoom figure, the mouse buttons may be used to perform the zooming. 

The left mouse button zooms in and the right mouse button zooms out.  A region may
be defined with the mouse in (when the icon is a magnifying glass) and this view will
zoom in on this region.  To turn off zooming, click the magnifying glass button again. 
Double-clicking on the magnifying glass sets the zoom back to 100%.  The zoom can
also be changed by simply pressing the up and down arrows next to the text displaying
the zoom scale or by typing a zoom amount into the text area.   

The slice currently in view is changed by pressing the up or down arrows
or by simply typing the desired slice into the text area. 

This button toggles the “normal” components view.  Since the window is two-
dimensional, components normal to the view are be displayed as dots. 

This button toggles the drawing of the grid representing entire geometry space. 
Turning on this grid is especially helpful when editing the geometry.

This button toggles the drawing of the electric components of the geometry. 
When viewing fields or editing the magnetic grid, it is sometimes useful to turn off
the geometry.
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Figure 4: The XFDTD 5.0 interface on a UNIX computer.

This button toggles the drawing of the magnetic components of the geometry.

(UNIX VERSION) - The UNIX version of XFDTD (Figure 4) has similar features for
viewing the geometry as mentioned above, but all views are contained in one window. 
To switch between grids, or to view all grids, the menu option View -> Set Viewing
Space is available.  Additionally, the grid pushbuttons to the left of the viewing window
allow switching between the main and sub grids.

6. Geometry Information (WINDOWS VERSION) – The pane on the right side of the
status bar (at the bottom of the XFDTD window) shows the position of the cursor within
the geometry.  When the cursor is outside the geometry, this pane becomes “Remcom,
Inc.”. Also in the status bar is a pane with information that describes the current
geometry.  The arrow button opens a menu with options for viewing  the spatial
increments and the dimensions of the geometry in cells and in physical units.
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Figure 5: The XFDTD Run Parameters window available in the Windows Version.

(UNIX VERSION) - The display for the location of the pointer is in the upper left corner
of the geometry window.  The spatial increments, number of cells, and other information
is displayed in the information area at the left of the geometry display.

7.  Run Parameters (WINDOWS VERSION) - When a project file (*.FDTD) is loaded,
the Run Parameters window is active as shown in Figure 5.  This window displays the
FDTD run parameters and the output data selected.  In the figure, the Sources page is
active. This shows the type of excitation (Voltage Feed) and the waveform (Sinusoid).
The window also shows time and frequency domain representations of the input
waveform.  Note that this is a steady-state calculation, so the tabs corresponding to that
type of input are visible.   When using a transient input such as a gaussian pulse, the
BFD, CCM, EFM, and SAR tabs would not be present but an additional tab for Far-
Zone Directions would.

(UNIX VERSION) - The UNIX version of XFDTD does not have a Run Parameters
window.  To view the Run Parameters, select the menu options for entering the
parameters.

8. XFDTD Project Tree (Figure 6)  This window displays the parameters of the
calculation in another form.  The Run Parameters are displayed hierarchically.  Clicking
+ expands the branch, and clicking - condenses it.  Double-clicking on the text of the
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Figure 6: XFDTD Project Tree

Figure 7: XFDTD Project Tree pop-
up menu in the Windows version.

parent item will also expand a branch.  In this figure, the parent item (monbox50.fdtd) is
shown expanded.  The Output Files branch is expanded showing all the outputs
specified for the loaded project.  When an item is in bold print, it is available for display
by double-clicking.  An item in the tree that is not in bold print is not available

(WINDOWS VERSION) - Clicking the
arrow at the top right corner of the
XFDTD Project Tree displays the
menu shown in Figure 7.  It provides
the ability to load single transient field
files, transient fields sequence files,
single steady-state files, and steady-
state sequence files.  Sequences of
steady-state files are created through
this menu.  The Refresh option will
“regrow” the Project Tree.  This is
useful for viewing intermediate output
files while a calculation is running. 
The tree will regrow automatically as
needed.

(UNIX VERSION) - The functions for
loading steady-state field files and
creating steady-state sequence files
are all available through the FILE menu on the main menu bar.
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5 File Types

XFDTD creates many different files for storing the geometry, calculation parameters,
and output. This chapter focuses on the types of files written by XFDTD.  All output
data from the calculation are viewed through the XFDTD interface and knowledge of
the actual filenames is not required.   For users who wish to use the output data from
an XFDTD calculation in another program, a detailed listing of the output file formats is
given in a later chapter.   Here a brief listing of the files created is given here as a
guide. 

Note: In this chapter the base file names of monbox and monrun will be used as
examples.  In actual use of XFDTD, these names are given within the program.

5-1 Geometry Files

Geometry files contain the data describing the location and content of the FDTD cells. 
These files always have the extension .id.  For example, the geometry of a monopole
on a rectangular box might be saved as the file monbox.id.

A geometry (often referred to as “.id” file) may be either a main grid or a subgrid.  Thus
a geometry file may be used alone for calculations, or it may be used as a subgrid with
a different geometry file serving as the main grid.   This removes the necessity for
having two different types of geometry files, while also allowing the use of the same
mesh in a different calculation.  For example, an antenna can be meshed and
calculations made on it as a main grid.  Then this same antenna geometry file can be
used as a subgrid, in conjunction with a main grid mesh using larger cells of a vehicle
on which the antenna is located.  When used as a subgrid, the cells for the geometry
must be smaller than those of the file used as the main grid mesh.  Alternatively the two
grids can be merged into one mesh with the same cell size.

Ratios between Main Grids and Subgrids

There is a constraint on subgrid meshes that the cell ratios between the main grid and
subgrid must be fixed at odd integer ratios.  That is, the subgrid cells must be one-third
or one-fifth the size (in each edge dimension) of the main grid cells.  Also the  number
of cells in each dimension of the subgrid geometry must align properly with the main
grid.   For proper alignment, the subgrid dimension NX, NY, and NZ must be evenly
divisible by either three or five, depending on the ratio of the subgrid.    If a geometry
file does not fit properly, a new mesh can be created that has the correct dimensions
and the geometry can be merged into it.  The Merge feature is covered in a later
section of the manual.

If a main grid is first created or read into XFDTD and then a subgrid is created, the
subgrid dimensions are entered as a number of main grid cells, and XFDTD
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automatically provides the correct number of subgrid cells to fit into the specified
portion of the main grid.

5-2 Project Files

Project files contain the calculation parameters and the filenames of any geometry files
associated with a particular calculation.  Project files have the extension .fdtd. 
Continuing the example from above with the monopole on a box, the project file might
be named monrun.fdtd.  The project file may also have the same name as the
geometry file.

5-3 Output Files

After the execution of the FDTD calculation program, many files might exist.  Which
files are created by the calculation program depends entirely on the run parameters
specified in the project file.  A listing of some common files created are listed here.  In
this section the assumption is made that the project file was named monrun.fdtd.
 
Transient field slice files - monrun.(varies).fld  

These files contain near-zone field data in particular slices of the geometry.  The
name is determined automatically depending on the location of the slice plane
and the timestep during the sample.  For example,     monrun.xy10.t100.fld
indicates fields in z=10 plane at time step 100.

Field screen show files - monrun.(varies).fss
These files contain a list of transient field slice file names for automatic display in
a movie format.  The slice plane of the geometry remains fixed and the movie
shows the field propagation versus time. The name is automatically determined. 
For example, monrun.xy10.fss indicates a screen show file of fields in z=10
plane

 Feed voltage and current file - monrun.vc
When a transient far-zone calculation is performed, this file contains three
columns of time, voltage, and current at the feed.  With the steady-state far-
zone, the file contains values for just two time steps just below the maximum
number of time steps.

Input impedance file - monrun.imp
This file contains the input impedance versus frequency.  There are three
columns: frequency (Hz), real and imaginary.

Near zone field samples files - monrun(varies)
These files hold near-zone values versus time at any location within the
geometry.  The near-zone value saved can be electric or magnetic fields or
currents.  As an example monrunEXS.x00010.y00020.z00030.g0 would contain
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the x-directed electric field component at cell location x,y,z (i,j,k) 10,20,30 is
saved.

Steady-State Field Quantities - monrun.(varies).sar, .cef, .bfd, .ccm
These files contain steady-state field magnitudes in a particular slice of the
geometry.  The steady-state values that can be saved include SAR (specific
absorption rate) files, electric field magnitudes, magnetic flux density
magnitudes, or conduction currents.  These files can be made into movies that
show the fields versus position in the geometry.

Diagnostics file - fdtd.diag
This file provides some basic information about the FDTD calculation
parameters including problem space size, cell size, time step size, and number
of time steps calculated.  Information on excitation, either pulse or sinusoidal, is
also provided. 

Progress file - tsfdtd
This file contains information regarding the progress of an FDTD calculation. 
Typically it contains three numbers: current time step, total number of time steps,
percent completion.

There are various other files created by the FDTD calculation program that are used for
postprocessing data.  For example files ending in .fza, .fzb , and .fzin are used only by
the postprocessors xpostpss50 and xpostp50.  Additionally there are files created by
the postprocessors such as antenna gain patterns or averaged SAR values.
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Figure 8:  File Menu

Figure 9:  Create New Grid 

6 The File Menu

The menus in the Windows version of XFDTD are standardized to match common
Windows NT and Windows 95/98 applications.   This chapter will discuss the first menu
option, the File menu.  As the UNIX version of XFDTD follows a different format, it is
covered in a separate section of the chapter that follows the Windows section.

6-1 The File Menu in Windows NT/95/98

Clicking on File opens the menu shown in
Figure 8.  The first three entries are for creating
a new file, opening a previously created
geometry or project file, or merging two
geometries together.  Following this are
standard “Save” options for saving either the
geometry or project file.  The “Close” option will
close the currently selected window.  The
options for printing are standard among
Windows programs and will not be discussed
here.  A listing of previously opened files is
attached to the bottom of the menu along with
the “Exit” choice.

6-1-1 New

The New option on the file menu is
used for creating new geometry or
project files.  If a geometry file is
already open, the New option will
create a subgrid geometry.  If a new
geometry is selected,  a panel
appears for entering the spatial
increment of the grid, the cellular
dimensions (number of cell edges in
each dimension), and whether
Electric or Magnetic components will
be in the mesh.  (Figure 9).  When
no magnetic materials (those with
permeabilities other than free space) are required, the magnetic components should
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not be selected.  The Quick Calc option displays the frequency and wavelength that
correspond to 10 cells per wavelength at the current spatial increment

If no geometry files are already open in XFDTD, selecting New will create a new main
grid.  When specifying the spatial increments (cell size) in the x, y, and z directions, the
cells should not deviate greatly from cubical.  A reasonable rule is to keep all cell
increments (cell edges) to within a factor of two in size.  The cell size is determined  by
both the geometry features and by the highest frequency.  The cells should be small
enough to describe the important geometry features, and no larger than approximately
one-tenth of the shortest wavelength of interest.  If the geometry includes dielectric
and/or magnetic material, the wavelength inside these materials must be considered
since it will be shorter than in the free space region of the FDTD space. 

If a geometry already exists when the New geometry is selected, the “Configure
Subgrid” menu opens.   This menu prompts for the subgrid offset within the main grid 
and the ratio of the subgrid cells.  The offset refers to the displacement of the origin of
the subgrid relative to the origin of the main grid.  This positions the subgrid within the
main grid.  The ratio refers to the cell size of the subgrid in relation to the main grid
cells.  Ratios of either one-third or one-fifth may be selected.

Note: the subgrid mesh appears to overlap slightly the main grid mesh.  This is normal
and is caused by the mesh interpolation of the magnetic fields rather than electric
fields.  For a cell size ratio of one-third, each of the grid dimensions NX, NY, NZ for the
subgrid must be evenly divisible by three (ie NX/3 is an integer).  For proper field
interpolation each subgrid dimension should be at least 4 main grid cells.  Thus for a
one-third cell subgrid, the minimum grid dimensions are 12 x 12 x 12 subgrid cells.  In
addition, if two subgrids are specified, both must have the same cell size.

After setting the offset and ratio of the new subgrid, the “Create New Geometry” panel
(Figure 9) will open and prompt for the same information as a main grid.  However,
when a subgrid is created, the spatial increment has already been selected
automatically and should not be modified.  The “Number of Cells” requested is in main
grid cells, not subgrid cells.  So, entering an NX value of 4 with a 3:1 subgrid will create
a new subgrid with an NX of 12.  

Subgrids may be specified to contain magnetic materials but for all calculations the
subgrid space is assumed to have free space permeability and no magnetic materials
will be visible in the subgrid.  If the subgrid is also used as a main grid in a separate
project, then the magnetic grid may be edited and used.
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6-1-2 Open

This option opens geometry or project files that have already been created.  To open a
file, either double click on the file or select it with the mouse and the select Open.
The project files contain the XFDTD calculation parameters and the geometry file name
(including subgrids), so opening a project file will also open the geometry. 

6-1-3 Merge

This feature merges two geometry files.  It is especially useful for modifying an existing
geometry by placing it in a new mesh that may be larger or smaller than the original. 
The Merge function prompts for a vector offset which allows for repositioning of one
geometry within another. Geometries can be merged into the main grid or one of the
subgrids.  

One application of using the Merge function might be when one geometry contains a
human head and another contains a portable telephone.   The two geometries can be
merged together to place the telephone near the head.  The resulting mesh can be
saved as a new geometry file.  This procedure can be repeated and with the telephone
in a different position.  
  
Another use of the Merge function is creating subgrids from existing main grid geometry
files.  If the grid dimensions of a geometry file are not correct for use as a subgrid, the
geometry can be merged into a mesh of the proper dimensions and saved as a new file. 

6-1-4 Save

This option saves either the geometry or calculation parameters, depending on which
window is currently active.  The main grid geometry and any existing subgrids are
saved separately.  If the file has not been saved before, a filename must be entered. 
Otherwise the file will be saved with the same name.  XFDTD automatically supplies
the suffix to the file name (either .id for a geometry file or .fdtd for a project file).  The
filename for geometry and project files can be the same, but it does not have to be.

Before writing a project file the corresponding geometry file for the main grid and for
any subgrids must be saved.  Also, some calculation parameters for both inputs and
outputs must be set before a project file can be saved.  

6-1-5 Save As

This option functions identically to the Save function above except it prompts for a
filename.  “Save As” will not automatically save a file under the same name.
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Figure 10: The File menu in the UNIX version of XFDTD 5.0

6-1-6 Close

The Close option closes the currently active window which may be a geometry or
project file.  Typically before loading a new geometry or project, any existing file should
be closed.  Before closing a file, XFDTD determines if the file has been modified and
asks if the file should be saved before closing.

6-1-7 Exit

Select this option to exit XFDTD.   XFDTD will ask if any unsaved files should be saved 

6-2 The File Menu in UNIX XFDTD

The File menu (Figure 10) is structured in a slightly different manner in the UNIX
version of XFDTD 5.0.  The features of the UNIX version are also present in the
Windows version.  This section briefly describes the menu items on the Unix File menu.

6-2-1 Open Geometry File

Choose this option to open a geometry file by itself.  A sub-menu gives the options of
Main Grid, Sub Grid 1, and Sub Grid 2.  Select the desired option while keeping in mind
that the first grid loaded should be the main grid, the second should be sub grid 1 and
so on.  Selecting Main Grid will open a File window (Figure 11) which will display the
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Figure 11: The File dialog box for
selecting a geometry file.

available geometry files in the current directory. 
Select a geometry file or use the other
features of the window to select a different
directory.  If one of the Sub Grids is selected, the
ratio of the subgrid cells to the main grid cells
must be specified before proceeding to select
the file.

6-2-2 Open XFDTD Project File

The Project file is selected in the same manner
as a geometry file.  The file dialog as shown in
30 will appear except this time it will display any
available project files (files with the .fdtd
extension).  Selecting a project file will
automatically load the associated geometry file.

6-2-3 Open Geometry File and Merge
with Present Geometry

Often it will be useful to modify a geometry file either by making the space larger or
smaller or by adding or deleting some part of the file.  One way this can be done is by
Merging one geometry with another.   For example, to take a certain geometry file and
increase the size of the entire space so as to add extra cells to the outer radiation
boundary, a new geometry can be created with a larger size and the existing geometry
can be merged into it.  To do this, the new geometry must be defined first, then select
the option to Merge the geometry.   The offsets of the old geometry in the new must be
entered for positioning.  Entering 0,0,0 for the offsets will position the new geometry in
the same cellular locations as before.  If the new geometry is 30 cells larger in every
dimension and the merged space is to be centered, enter offsets of 15,15,15. 

6-2-4 Adjust Merge Characteristics

This option is used for defining which materials will take precedence over others when
merging.  When loading an existing geometry into a blank space, this feature is not
applicable.  However in some instances there are two existing geometries which will be
merged.  This function defines which materials will overwrite others should the two
geometries overlap.   Selecting this option will open the menu shown in Figure 12
where the choices of Electrical and Magnetic mask are used for defining the overlap of
either the electrical or magnetic components.
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Figure 12: The Adjust Merge Characteristics menu.

6-2-5 Open ... File

There are four choices of output files which may be opened.  Each is described below.

Open Single Transient Field File

Select this option to open a single time-domain field file.  For the currently loaded
geometry, the field files can be selected from the Project Tree.  However occasionally a
field file from a different calculation is desired.  This menu option can be used for
opening field files that are not in the Project tree, or simply as an alternative to the
Project tree.

Open Transient Field Sequence File

This option has the same function as the time-domain field file menu item mentioned
above, but it is for sequence of time-domain field files. 

Open Single Steady State Data File

Used for opening single steady state files which may be either SAR, electric field
magnitudes, magnetic flux densities, conduction current magnitudes, or surface
currents.  

Open Steady State Data Sequence File

This option is used for opening individual sequences of steady-state files.  There is
also an option to create these files if they were not already computed by the calculation
program.

6-2-6 Create New Space 

Use this option for creating a new space.  A menu similar to that shown in 26 will open. 
Define the parameters of cell size, number of cells in each direction, and the grids to
create.  Unless magnetic materials (non-free space permeability) will be used, the
magnetic grid should not be defined.
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6-2-7 Show Information Window

This option opens a separate window with information about the loaded geometry. 

6-2-8 Save Geometry

Select this option to save a geometry file.  Select whether the file should be saved as
either a main grid or a subgrid.  A File box will open allowing the directory and filename
of the geometry to be entered.

6-2-9 Save XFDTD Project File

This saves the Project file currently loaded.  

6-2-10 Destroy Existing Space

If a geometry is loaded but no longer desired, it can be removed with this option.  This
is useful for removing a subgrid from a project.  

6-2-11 Quit

Select this option to exit the XFDTD program.
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Figure 13: The Edit menu of the
Geometry window in the Windows
version of XFDTD 5.0.

7 Edit Menu - Geometry  

In the Windows version of XFDTD the Edit menu
performs different functions depending on whether
a geometry or project file is active.  This chapter
describes the features of the Edit menu for a
geometry window.  The Edit menu in the Unix
version of XFDTD is analogous to the Windows
Geometry Edit menu.   The Edit sub-menu choices
of the Windows version are shown in Figure 13. 
The editing tools Undo, Redo, Cut, Copy, Paste,
and Delete are included in the Windows Version
only.  Other panels for entering and modifying the
Geometry, dielectric and magnetic Material
Parameters, and the subgrid location within the
main grid are available.  The spatial increments for
a geometry can be modified from this menu as well
as the orientation of the geometry.  If a dual grid is
required, for example when a complicated
geometry was generated assuming only dielectric
materials and at a later time magnetic materials are
desired, it can be added here.  The Remesh and
Rotate optional features are accessed through this menu if that module has been
added to the basic XFDTD package.   The Tissue material parameters of the Remcom
High-Fidelity human meshes (an optional feature available for purchase) can be
automatically adjusted to a specific frequency using the Adjust Tissue Material
Parameters menu.   Finally, preferences controlling the functionality and appearance of
XFDTD can be modified.

7-1 Geometry Editing

Geometry editing in XFDTD is done by the definition of objects.  These objects may be
chosen from a library of “primitives” or by creating a user-defined object which is
defined using mouse-driven editing tools.  The geometry is entered by defining the
electric or magnetic material parameters of cell edges which correspond to either
electric field locations (for the electric grid) or magnetic field locations (for the magnetic
grid).  Setting the electrical (or magnetic) properties of a cell location such as the
permittivity and conductivity changes how the electric (or magnetic) fields are updated
by the calculation program.  This effectively adds a material with those properties to
that location. 
 
Open the Geometry Editing Tools panel to edit the geometry.    A window lists any
objects that are defined and whether the object is meshed or not.  A library of objects is
available for meshing which includes a user-defined object.   The editing tools
described in more detail in a later section.
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Figure 14: Edit
Electric Materials
panel

 A material palette is included in Windows for adding new dielectric or magnetic
materials and defining their properties. The Electrical and Magnetic Material
Parameters menus provide the Material Palette function in the UNIX version. 

7-2 The Material Palette - Windows Version Only 

In Windows when Geometry..., Electric Material Parameters..., or
Edit Magnetic Materials is selected, the corresponding Material
Palette appears. Figure 14 shows the Electrical Materials
Palette.  Each color on the palette represents a different material
type.  Black (number 0) and White (number 1) always correspond
to free space and Perfect Electric Conductor (PEC) respectively
and cannot be changed.  To add a new user-defined material type,
click Add... .  Either the next available material may be selected or
a particular color.  Each color represents a particular material
though and may only be used once.  To aid in identifying different
materials, a material description may be entered in the area
provided.  XFDTD will store this name with the other material
parameters to allow easy identification of different materials.  If
editing electrical materials, there is also the option to Add Thin Wire. Thin wires may
be used when the geometry requires a wire with a very thin radius which is much less
than the cell size.  It should be noted that a wire constructed of a single edge of PEC 
has an effective radius of approximately ¼ of a cell.  Thin wires always appear with
cross-hatched color. 

7-3 Specifying Electrical Materials

Often materials other than free space and perfect electric conductor are needed for a
particular geometry.  To create a new material in Windows, select Add... from the
Material Palette.  You can choose whether you want the next available color or
whether you want to select a specific color.  Either choice brings up the Edit Electric
Material window (Figure 15).  In the Unix version the equivalent operation is to open
the Electrical Materials Parameter Window from the Edit->Geometry menu.

Clicking this button on the tool bar will display the Electric Materials Palette
(Windows) and display the electric components of the grid.

The Edit Electric Material window (for Windows) or the Electrical Material Parameters
window (for Unix) is used to edit the values of constitutive parameters for dielectric
materials, including frequency-dependent dielectrics. XFDTD has three options for
dielectric material models.  For a normal dielectric, one in which the electrical
properties do not vary significantly with frequency, the conductivity in Siemens/meter
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Figure 15: Edit Electric Material window

and relative permittivity may be set.  These values may be found in tables or other
sources.  Typically when a good conductor is to be included in an FDTD calculation,  a
perfect conductor should be used as an approximation.  Trying to  include the effects of
a good conductor (rather than perfect conductor) may be difficult since the wavelength
inside the good conductor will become very small, requiring extremely small FDTD cells
to provide adequate sampling of the field values inside the material.  If only the surface
losses are of interest, in a cavity for example, approximate methods for determining an
equivalent conductivity for FDTD calculations are discussed in [11].

In many FDTD calculations, a normal dielectric specification for most materials will be
sufficient.  However, for wide-band pulse excitations, some materials exhibit significant
changes in their permittivity.  The two most common ways to specify the frequency
behavior of such materials are the Debye and Lorentz functions.  

For a Debye material, the electrical conductivity in S/m, infinite frequency relative
permittivity, static relative permittivity, and relaxation time in seconds are set in the Edit
Electrical Material (Windows) or Electrical Material Parameters (UNIX) window.  For a
Lorentz material, the conductivity in S/m, infinite frequency relative permittivity, static
relative permittivity, resonant frequency in Hz, and damping coefficient in Hz must be
specified.  For a detailed discussion of these materials, refer to Chapter 8 of [7]. 

If one or more sub-grids are included in the FDTD calculation, the dielectric material
parameters can be set independently for each grid.  The process of adding a material
must be repeated for the subgrids and different parameters can be set for materials in
the subgrid. 

7-4 Specifying Magnetic Materials

Magnetic material permeability and magnetic conductivity are specified for each
magnetic material type using either a panel similar to the Electric Material Panel
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Figure 16: Defining an anisotropic magnetic
material in XFDTD 5.0.

(Windows) or a menu analogous to the Electrical Material Parameters menu (UNIX). 
These choices are only available if the magnetic grid was created with the geometry.  If
the magnetic is grid is desired but does not exist, it can be added through the “Add
Dual Grid” function (discussed later).  

Simple magnetic materials (referred to as “normal”) have relative permeability and
“magnetic conductivity” values which may be found in tables for some materials.  These
values can be derived from complex permeabilities as well.  Frequency-dependent
anisotropic magnetized ferrites require the specification of five material parameters
(see Figure 16).  The first three ferrite material parameters are the Larmor precession
frequency (in radians/sec), the frequency corresponding to the saturation magnetization
(in rad/sec), and the damping coefficient.  The fourth and fifth parameters are the theta
and phi angles (in degrees) which specify the direction of the static magnetic field.  The
form of the permeability tensor used for the ferrites is discussed in references
[12,13,14,15].  The first two references do not discuss the damping coefficient.
Reference [15] gives the parameters for some commercially available ferrites in
Appendix 12.1

Clicking this button on the tool bar will show the Magnetic Material Palette
(Windows) and display the magnetic components of the grid.
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Figure 17: Edit Thin Wire Parameters window

7-5 Specifying Material Densities

Material densities are required for performing Specific Absorption Rate (SAR)
calculations.  This option is only available in the Bio-Pro Version of XFDTD.  The
Material Densities may be entered using the Edit Electric Material window in the
Windows Version or the Edit Material Densities Menu in the Unix Version.  The
densities of the material must be entered in kg/m3 for SAR calculations. 

Note 1:  Make sure densities are entered in  kg/m3 as many handbooks provide
material densities in g/cm3.

Note 2: If non-biological lossy dielectric materials are present (perhaps a plastic cover
for a cellular phone) setting the material density of that XFDTD material type to zero will
indicate to XFDTD that SAR results are not desired for that material.

7-6 Edit Thin Wires

Thin Wire materials may be
used in special situations
where a wire with a radius
much smaller than the cell
size is required. Figure 17
shows the window for editing
the thin wire radii in the
Windows version.   In most
cases, material #2 (PEC), will
serve well as a wire.  The
Edit Thin Wire Parameters
window is accessible through
the Electrical Materials Palette in Windows and from the Utilities Menu on the
Geometry Editing Tools panel in UNIX.

Note: Thin wire materials may not be located adjacent to each other and may not cross
each other.  There must always be at least two cells between any non-colinear thin
wires.  
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Figure 18: Geometry Editing Tools (Windows Version)

Figure 19: Geometry Editing Tools in the Unix Version

7-7  Geometry Editing Tools

The geometry for a
calculation can be
entered into XFDTD
through the Geometry
Editing Tools.  The
geometry may be edited
by creating user-defined
objects with  mouse-
driven tools or from a
library of primitive
shapes.  The Geometry
Editing Tools in the
Windows version are
shown in Figure 18. 
The corresponding
window from the UNIX version is shown in Figure 19.

Click this button in the tool bar to show the Geometry Editing Tools window.

The Geometry Editing Tools are controlled by a series of buttons which appear in the
middle of the panel.  The list of objects in the space shows all items in the geometry,
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Figure 20: Editing tools

whether they are meshed or not.  If an object is meshed, the letter “m” will appear in the
first column of the list.  If it is unmeshed, the letter “u” will be displayed.  The objects in
the list are meshed with items at the top of the list having priority over items at the
bottom of the list.  Items are added to the list at the top, so the last object added will
have the highest priority in meshing.   The order of objects on the list can be change by
clicking on an item in the list and then pressing Selected->Move (up/down/to top/to
bottom).   Other features of the “Selected” menu include meshing/unmeshing and
deleting an object from the list.

To add a new object to the list, press the New button and select one of the choices from
the library or primitives.  Each of the primitives is described later in this chapter.   After
adding the item to the list, it can be meshed by pressing the Mesh All button.  If the
order of the items on the list has changed, the display of the mesh can be refreshed by
pressing the Remsh All button.  To clear the list of all objects, press the Delete All
button.

7-7-1 User-Defined Objects

A user-defined object can be created using the edit mode buttons (shown in Figure 20)
which are for different manual (mouse-driven) editing modes.  To create a user-defined
object, select Library->Begin user-defined (UNIX) or New->User Object (Windows) 
from the Geometry Editing Tools window.  
The edit mode buttons will then become
available for use.   There is also a space
provided for naming the user-defined object
for future reference.  Otherwise the object will
appear on the list as simply “User Object”.  The first three buttons are single-click
operations.  The first button sets single edges of cells. The second sets one face of a
cube while the third sets an entire cube directed normal to the viewing plane.  The next
five buttons allow definition of areas cells. The button labeled “X” will set only the X-
directed components inside an area defined by the mouse.  The “Y” and “Z” labeled
buttons function similarly.  The button (with an icon of one square above another)
draws two-dimensional “sheets” of cells in an area defined by the mouse.  The editing
button with the “two-cube” icon will set all geometry edges in the area selected.  This
includes those components normal to the view.  The last two buttons on the bar are for
copying an area and for rotating an area of cells.  When finished, press Library->End
user-defined (Unix) or End Object (Windows) to complete the user-defined object.  
When editing electric components, the dielectric material locations naturally align with
the grid.  However, when placing magnetic components in the grid, the material
locations are offset by ½ a cell in all directions.  This convention is used to represent
the locations for the electric and magnetic materials in the Yee cell geometry [7].  This
may seem confusing when using the interactive mouse controlled editing of a magnetic
mesh, but it is easy to adapt to this.
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Figure 21: Library menu

To aid in finding specific locations in the geometry, XFDTD displays the position of the
mouse pointer.  In the Windows version the mouse pointer location is displayed on the
right-most pane of the status bar.  In the Unix Version the pointer location is drawn in
the upper right corner of the geometry window.  As the pointer is moved in the geometry
window, the location (in cells) is updated, including the orientation of the edge under
the pointer (X, Y, or Z).  This position display is especially helpful in locating the
voltage and/or current sources and other geometry features.  The material number at
each edge is also shown as the pointer is moved through the space. 

7-7-2 Additional Layers in Geometry

For adding features to a User-defined object which extend through several layers
above and/or below the current viewing plane, the Edit Geometry Tools window
provides the ability to duplicate editing actions through additional layers.  This is
accomplished by setting the editing depth in the Additional Layers field.  For example,
if the view is set to the XY plane at Z=25, and the above editing depth is set to 5, the
same changes made in plane Z=25 will appear in planes Z=26 through Z=30.  This
greatly simplifies the description of geometry shapes that have a constant cross section
and extend over multiple layers of the space.  The vertical bar on the right of the Edit
Geometry Tools window provides visual feedback of the editing characteristics.

7-7-3 Library

The Geometry Edit Panel also contains a library of
primitive objects which may be used to build a
geometry.  These are accessed by clicking on New...
in the Windows version or by selecting Library in the
UNIX version of the Edit Panel.  The resulting menu is
shown in Figure 21.

The primitive library contains several objects that can
be used to create many parts of a complex geometry. 
Included in the library are a circular cylinder and conic, a helix, a plate (either aligned
with the grid or tilted), a rectangular box, a sphere, some basic spiral antennas and a
wire.  The positioning, size and composition of the objects is controlled by the individual
menus.  For all of the menus (unless otherwise noted) the units requested are FDTD
cells.
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Figure 22: The circular cylinder and
conic edit menu.

Figure 23: The helix primitive menu.

7-7-3-1 Circular Cylinder and Conic

The circular cylinder and conic menu (Figure 22) is
used for adding cylindrical objects of any material to
the geometry.  Two points along the centerline of
the cylinder are needed for determining the location
of the cylinder in the grid.  The cylinder does not
need to be aligned with the grid.  The inner and
outer radii of the cylinder at each point define the
shape of the cylinder.  By setting one outer radius
to zero, a cone is made rather than a cylinder.  If
the cylinder is constructed of dielectric or magnetic
materials, either 1 or 3 levels of fuzzy cells may be
used on the out edges of the cylinder.  Fuzzy cells
are described in another section of this manual.

7-7-3-2 Helix

The helix is a complex object to mesh
and since it is a commonly used antenna
in the telecommunication industry, a
primitive of the helix has been added to
the XFDTD library.  There are numerous
parameters that must be set for the helix
primitive (Figure 23).  Two data points
are needed for defining the central axis
of the helix.   This line does not need to
align with the grid.  Next a starting point
of the helix is required.  Again this is an
X,Y,Z coordinate of the first cell of the
helix.  The “stopping” point will be
computed automatically but can be
viewed to check for accuracy.  The
number of cells per turn of the helix is
used for entering the helix pitch while the
number of turns is self-explanatory.  The
polarity (direction of the turn) is requested along with the wire thickness of the helix.  If
the wire of the helix is small compared to the dimensions, the “Single Component”
choice should be selected.  Otherwise a radius in cells may be entered.
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Figure 24: 1-component thick
rectangular plate menu.

Figure 25: The quadrilateral plate
menu.

7-7-3-3 Plate:  1-component thick rectangular

The rectangular plate (Figure 24) is a two-
dimensional object that may be rotated around
one of the principle axes.  The plate is first
defined aligned with one of the principle axes and
then a rotation angle can be specified.  The
location of the center of the plate must be entered
along with the dimensions of width and depth.  
The initial orientation is used for sizing the plate
and then the rotation angle and axis of rotation
define the final position of the plate.   

7-7-3-4 Plate:  1-component thick quadrilateral

The quadrilateral plate (Figure 25) is more general than the rectangular plate, but Is
more complex and should be used when the rotation angle is around more than one
axis.  For this plate, three points are requested to define the plane of the plate.  A fourth
point defines a desired point in the plane.  The program will compute the actual fourth
point based on the input given.  This computed fourth point is shown in the “Actual” part
of the window.
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Figure 26: Rectangular Box menu

Figure 28: The spiral antenna primitive
menu.

Figure 27: The sphere primitive
menu.

7-7-3-5 Rectangular Box

The rectangular box is used for defining a large
volume of cells quickly (Figure 26).  Three points
on the box are requested along with the
thickness of the box.  The three points should be
three corners on a plane through the center of
the box.  The thickness will set the extent in cells
of the box above and below this plane.  The
thickness does not need to be an integer number,
but it will be rounded to the nearest cell.  

Note: To make an odd numbered thickness,
select the center point of the box to be in the
middle of a cell.

7-7-3-6 Sphere

The sphere (Figure 27) requires a center point and
an inner and outer radius.  The sphere may also
be meshed using “fuzzy” cells on the outer edges,
if desired.  

7-7-3-7 Spiral antenna

Spiral antennas are complicated objects to enter
in FDTD cells (Figure 28).  A primitive has been
added to XFDTD for three possible spiral antenna
designs:   semi-circular [8], equiangular [9] and
Archimedean [10].   The parameters required vary
depending on the type of spiral being built.  Each
of the types may be constructed using the
suggested parameters below but the references
for each antenna should be used for an exact
determination of the parameters required for a
specific design.  

Semi-Circular:
Create an FDTD space with dimensions (in cells) of 178x179x31 with 2.5 mm spatial
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Figure 29: The Wire primitive menu.

increment. In the spiral antenna parameters window choose Semi-Circular.  Set the
Width to 1 cm and the Turns at 3.  Mesh the antenna in the XY plane at the center of
the space 

Equiangular:
Create an FDTD main grid space 124x158x31 cells with 2.0 mm spatial increment
Use the edit panel to set the cell edges in the z=16 plane to PEC.  In the spiral antenna
parameters menu choose Equiangular.  Set the Min Radius at 0.005 m, the Expan Rate
at 0.303, the Ratio at 0.75, and the Length at 0.428.  Mesh the antenna in the center of
the XY plane at z (k) = 16

Archimedean:
Create an FDTD main grid space 180x180x31 cells with 0.3 mm spatial increment
In the spiral antenna parameters menu choose Archimedean.  Set the width at 0.00334,
the minimum radius at 0.00334, the expansion rate at 0.00835, and the circumference
at 0.167.

7-7-3-8 Wire

The wire (Figure 29) is a very useful
primitive object.  All that is required are the
two endpoints of the wire.  If the wire
material in PEC, the wire may lie at any
orientation on the grid.  If the thin wire
material has been chosen, the wire must
be aligned with the grid.  Thin wires may
not be “staircased” as this will lead to instabilities in the calculation.  

7-7-4  Fuzzy Cells

In order to improve the fidelity of the FDTD results for dielectric objects, the cylinder
and sphere library objects can be meshed using "fuzzy" cells on the surface.  Fuzzy
cells use values of permittivity and conductivity intermediate between free space and
the values of the material.  The staircase error involved in meshing curved dielectric
surfaces with rectangular cells is reduced using fuzzy cells.  The fuzzy cell values are
automatically calculated and assigned.  The fuzzy cells are displayed in a lower color
intensity.  That is, all cells of the same material type are displayed as the same color,
but fuzzy cells with intermediate permittivity and/or conductivity are displayed with lower
intensity.  Fuzzy cell meshing is not helpful for PEC targets. 
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Figure 30: Change Spatial Increment window

While XFDTD automatically adjusts the relative permittivity on the surfaces of these
dielectric spheres and cylinders, the permittivity of flat surfaces of dielectric objects may
be adjusted manually.  For this purpose a manual selection of Fuzzy levels is available
from the Edit Panel.  If a cell is entirely within a dielectric material, fuzzy cells should
not be used.  Note that if a cell is on the boundary between two dielectric materials, the
cell is in effect halfway in one material and halfway in the other.  

For example, consider the mesh edge locations tangent to a flat dielectric/air interface
(at the surface of a dielectric substrate for example).  The permittivity of these mesh
edges should be set to ( +1)/2 (the 1 for relative permittivity of free space) and the
conductivity to /2, where  and  are the relative permittivity and conductivity in
Siemens/meter of the dielectric.  This corresponds to selecting the 50% Fuzzy level
from the edit menu for the dielectric at these surface mesh locations.  If the adjoining
dielectric is not air, then the permittivity and conductivity are set to the average values
of the two materials.  In XFDTD it is assumed that the material is adjacent to air, and a
fuzzy level of x% means that the relative permittivity for that mesh location is set to
[x +(100-x)]/100 and the conductivity is set to  x /100.  Other situations can be
accommodated by using a different dielectric material number for the intermediate
“fuzzy” layer and setting its constitutive parameters appropriately.

This same correction should be applied to magnetic materials.  Of course if the
adjoining material is perfect conductor, then any electric fields tangent to the surface of
a perfect conductor are set as perfect conductor regardless of the constitutive
parameters of the adjoining material.

7-8 Spatial Increment

With the Change Spatial Increment
window the cell size of the cells in an
FDTD geometry may be adjusted. (Figure
30)  This will not change the numbers or
locations of FDTD cells, only the cell size. 
This option should be used for make
adjustments or changes of scale. 
Remember than a 10x10 cell plate will still
be 10x10 cells, but the actual dimension
in physical units will change based on the
values entered on this window.

7-9  Add Dual Grid

Add Dual Grid may be used to add either the magnetic or electric grids to a geometry. 
In most circumstances this feature would be used if a geometry was defined with only
the electric grid and at a later time some magnetic material was desired.  By using this
feature the dual grid will be added to the geometry and will be available for editing. 
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Adding the dual grid will increase the memory storage requirements of the geometry
because three new three dimensional arrays will be added.  Also the calculations of the
field equations by the calculation program will become slightly more complex.  So, the
dual grid should only be added when it is required. 

Note that subgrids will not use magnetic materials in the FDTD calculations.  Magnetic
materials may be defined in a subgrid geometry for cases where the subgrid will also be
used as a main grid.  However, any magnetic materials in a subgrid will be treated as
free space by the calculation program. 

7-10  Preferences

The Preferences window allows control over numerous features of XFDTD.  The values
entered on the Preference window will be stored and used every time XFDTD is run in
the future.  

The default units in both spatial and frequency terms may be modified to fit individual
situations.  The options for frequency can range from Hertz to TeraHertz while spatial
units may be displayed in both metric or English values.  XFDTD will use these units for
any display of data.

Windows Version Preferences

The Windows version of XFDTD has some specialized preferences for controlling the
appearance and function of XFDTD.  The Interface preferences allows selection of
which windows in XFDTD are dockable.  Dockable windows are those that can be
attached to the sides of the main frame window.  To dock a window, click and drag it to
the edge of the XFDTD frame window.  The outline of the window will shrink when it will
dock.  To undock or float a window, double click on it, or drag the window off the frame. 
If windows are set as dockable, they may be moved without attaching by holding the
Control key while moving.  

The Material Palette section controls the display of materials on the material palette. 
Materials will be display either with the material descriptions entered, or by the material
number.

The XFDTD Project Tree section controls the behavior of the Project Tree.  The
Project Tree can either display a text description for each item in the tree, or the actual
filename for that data.

The Quick Draw field display option controls how the field snapshots are drawn on the
screen.  The fields may be drawn using the actual field values at each cell location, or
an interpolated version of the fields may be shown which presents a smoother transition
of the fields.  When Quick Draw is selected, the actual field values will be displayed
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rather than the interpolated fields.  The selection of Quick Draw will increase the speed
in which fields are loaded and movies are presented. 

The number of Undo levels for editing may be adjusted as well. The default setting for
Undo is 2, but this can be increased as needed.  The limitation on increasing the
number of Undo levels is the memory requirement for storing changes to large areas of
the geometry.  When actions are stored in the undo list, the Information button will
provide an estimate of the amount of memory used.
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8 View Menu

8-1 The View Menu in Windows XFDTD

Like the other menu items, the menu has different contents depending on which window
is currently active.  View has different contents for depending whether the active
window is a geometry, the run parameters, or a plot. The following items are common
regardless of which view is active:

� XFDTD Project Tree - Toggles the XFDTD Project tree.  The Project Tree
displays all the files in the current project.  Selecting items in the Project Tree
will switch the geometry in view or open output files.   

� Calculation Progress - Toggles the output window showing the status of any
calculation which may have been started. 

� Tool Bar - Toggles the toolbar display.   The toolbar is the row of buttons which
provide instant access to various commonly used functions. 

� Status Bar - Toggles the status bar located across the bottom of the XFDTD
frame window.  The Status Bar shows the file loading progress and the status of
other operations.  More importantly, the status bar displays location of the
pointer in a geometry as well as information about the active geometry.

The following items are only available when a geometry view is active:

U Grid - Toggles drawing of the grid.  The grid is drawn as a medium-gray graph
that designates the size and position of the geometry.  The drawing grid is in
alignment with the electric components of the geometry.

U Normal Elements - Toggles the drawing of the components normal to the
current viewing plane.  Normal components are drawn as circles in the color of
the material.  This setting is independent for each of the principle planar views.

U Electric Components - Toggles the drawing of the electric components.  When
both an electric and magnetic grid are present, or when fields displayed, it is
sometimes useful to turn off the electric components. .

U Magnetic Components - Toggles the drawing of the magnetic components.  
U Background Color - This menu item controls the color of the geometry window

background.  Note that the drawing background is switch to white for printing
automatically.

U Export .BMP - Exports the current view to a bitmap of a user-defined size.    The
size of the output bitmap must be entered followed by the filename.

8-2 The View Menu in Unix XFDTD

In the Unix version of XFDTD, the View menu does not change as there are not
separate windows for the Geometry and Run Parameters.  The menu will appear as
shown in Figure 31.  The Hide Toolbar option removes the toolbar from the interface



49

Figure 31: The view menu in XFDTD 5.0 on a
Unix computer.

window.  Selecting this option again will
replace the toolbar.  Use the Set Viewing
Space item to change which grid is
currently in the view.  The options for
turning on and off the grid, normal
elements, electrical components, and
magnetic components follow.  Select 3D
Mode to view the geometry in three
dimensions.  Drawing Area Background is
used to change the color of the geometry
window.
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Figure 32: The Edit-Run Parameters
menu in the Windows version of
XFDTD.

9 Edit - Run Parameters 

The input and output parameters for an FDTD
calculation are defined on the Edit menu of the
Run Parameters window (see Figure 32).  In the
UNIX version of XFDTD these options are found
simply under the Edit menu while in the Windows
Version the Run Parameters window must be
active to view these menu choices.  Some of the
calculation parameters menus may be accessed
through the toolbar.   

There are many calculation options with XFDTD
and the available outputs are dependent on the
type of input selected.   The inputs, which are
covered in the first section of this chapter, must
be chosen carefully according to the type of result
desired.  XFDTD can generate both broadband
and single frequency results and due to the different calculation methods used for
generating output, one type often is more useful than another for a particular project.

9-1 Stimulus

The Stimulus refers to the input used by XFDTD.  There are three broad types of
inputs: near-zone sources, incident plane waves, and TEM excitation planes.  The most
commonly used input is typically the near-zone source.   Incident plane wave
calculations are useful for applications where the scattering or absorption of fields by
an object is desired.  The TEM excitation mode is a specialized input which is
described later.  For many simulations involving antennas or microwave circuits, the
near-zone source input is used.  

9-1-1  Sources/Loads (S-Parameter Port Setup)

The Sources/Loads window is used for FDTD calculations involving near-zone voltage
and/or current source or lumped RLC circuit elements.  In antenna calculations, the
desired input is usually considered the “feed” while for S-parameter calculations, “ports”
must be defined.  For XFDTD these two concepts are nearly identical and so the terms
“feed” and “port” are often used interchangeably.  

A feed is a cell edge on which the electric field is modified by the addition of some type
of input waveform.  A port is also a cell edge where an input may be added or the near-
zone values of voltage and current may be monitored.  In either case, the cell edge can
be modified to behave like a voltage or current source, or have some value of
resistance, inductance or capacitance.  
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Figure 33: The sources/loads stimulus menu.

Regardless of whether the input is considered a feed or a port, the necessary
parameters are defined on the Sources/Loads menu (Figure 33).  This menu is opened
by selecting Edit->Stimulus->Sources/Loads. 

Note: A port or feed may be entered easily by moving the mouse pointer to the desired
cell edge and pressing the right mouse button.  From the popup menu select Edit Port. 
This will open the Sources/Loads menu with the location and direction of the feed
already entered.  

9-1-1-1 Setting the Feed/Port Location

The Sources/Loads menu contains a section which describes the location of the feed. 
The grid of the feed must be selected appropriately.  If there is only a main grid in the
project, then this will be the only choice available.  If there are one or more subgrids,
then the proper grid must be selected.  Next enter the X,Y,Z location of the desired cell
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edge.  The feed will either be aligned with the X, Y or Z axes, so select the direction as
either “X-directed”, “Y-directed”, or “Z-directed”.    

Note: Feeds/ports may not be located adjacent to each other unless the RLC values
are all set to “none”.  Feeds/Ports can be end-to-end, but the can not be side-by-side.

9-1-1-2 Feed/Port Parameters 

Each port in XFDTD may have several parameters associated with it.  The port
contains a source, the source may be a voltage or a current.  The source may be added
in series or parallel.  Otherwise, if no source is desired, a passive lumped load may be
specified by selecting No Source. 

Note:  For all voltage source specifications the values given are peak values, not RMS. 

If a source is defined, the amplitude of the input waveform may be specified as well as
the polarity.  The phase of the source may be selected if the input waveform is a
sinusoid, otherwise this option will be unavailable.   

XFDTD also has the capability of simulating lumped RLC (Resistor/Inductor/Capacitor)
elements at a port location.   The RLC elements will be added either in series or
parallel depending on which choice is selected.   For all cases, the load will be in series
with the voltage source and in parallel with the current source.  The “series” and
“parallel” choices refer to how the RLC components are added with respect to each
other.  For the series combination, all of the lumped circuit elements are in series and
are located on one FDTD mesh edge.   For a parallel combination, all of the lumped
circuit elements are in parallel located on one FDTD mesh edge.  The voltage across
the mesh edge (electric field times edge length) includes both the load and the source
voltage (if present).  The FDTD calculated current is always the total current through
the cell edge and includes both current through the load and through the current source
(if present).

If you wish to place a voltage source in parallel with the load or a current source in
series with the load, you should place the source and load in adjacent cells
(side-by-side in the first case, and end-to-end in the second).   The RLC values for the
voltage or current source should be set to “none” for this situation.  

Source Resistance

An important advantage of including a source resistance is reducing the number of
FDTD time steps necessary for convergence in transient calculations.  This is
especially important for resonant devices such as many antenna and microstrip circuits. 
With a "hard" source consisting of a voltage source without series resistance, a
resonant microstrip antenna may require 64,000 time steps for the transients to
dissipate.  The addition of a 50 ohm source resistance might reduce this to 4,000 time
steps.  Similar time savings may be encountered for microwave circuits.  The source
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resistance should be chosen as closely as possible to match the source to what is
being driven.  So, for a microstrip problem with 50 ohm characteristic impedance a
source resistance of 50 ohms would be a good choice. 
 
When making calculations that include the input voltage, current and/or power in the
calculation formula, such as antenna gain or S-Parameter values, the input voltage,
current and/or power will be that provided at the terminals of the mesh edge.  In
particular, the power dissipated in the source/load resistor will not be included in the
input power.  For example, the gain of antenna is reduced if any power is dissipated in
lossy materials in the antenna, since this power is, therefore, not radiated.  In XFDTD,
since the voltage, current, and input power are calculated at the mesh edge,  the gain
of antenna will not be affected by the value of the source resistance.  Similarly, for input
impedance calculations, the source resistance, capacitance and inductance values will
not be included in the input impedance. 

Note:  The source resistance cannot be made too high or instability may result.  In the
source resistance calculation the displacement (capacitive) current through the FDTD
cell is neglected.  If the source resistance is made high enough so that the neglected
displacement current become larger than the conduction current through the source
resistance, Maxwell’s equations will not be satisfied and the FDTD calculation may go
unstable.

9-1-1-3 Modifying Feed/Port Parameters

If a feed location was entered incorrectly, or it has moved, the entry may be edited
simply by follow the procedure below. 

1) Select the feed from the list.  

2) Make the desired changes to the Feed Specifications.  While the changes are being
made, the selected feed will remain highlighted.

3) Click on Modify Selected Feed to replace the selected feed with the new
specifications.

9-1-1-4  Multiple Voltage and/or Current Sources

For calculations with multiple voltage and/or current sources, such as antenna arrays or
multi-port S-parameter calculations, multiple feed points can be specified with the
Sources/Loads window.  For transient feeds, each source function must have the same
pulse width and amplitude, or use the same user supplied file of voltage versus time. 
The polarity can be adjusted by clicking the desired button.  This may be useful in
controlling the sign of the phase terms in S-parameter calculations. For each feed,
independent source resistances may be specified.  For sinusoidal excitations, each
feed can be specified with a different magnitude and phase. 
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For antenna calculations, keep in mind that determining a good approximation to an
actual antenna feed is not always simple.  Many antennas are fed with coaxial cable. 
The simplest approach to simulating this is to locate a source in line with the center
conductor of the coaxial cable where the cable is connected to the antenna.  This will
result in an impedance at this point in the cable.  See the monopole antenna on
conducting box example later in this manual for details.  For transient calculations,
including a source resistance equal to the impedance of the coaxial cable being
approximated should reduce the number of time steps needed for the transients to
dissipate.  It is similar to driving an actual circuit or antenna using a matched source. 

9-1-1-5  S-Parameter Calculations

Any number of individual ports for S-parameter calculations may be specified in the
Sources/Loads window.  Each port can have a different source resistance.  Lumped
reactive elements should not be used in the active port specification.  The S-
parameters at each port will be calculated relative to the source resistance as the value
of the characteristic impedance of the transmission line feeding the port.  For instance,
if the S-parameters would be measured using 50 Ohm cables then the source
resistance should be specified as 50 Ohms. Examples for both stripline and microstrip
circuits are given in this manual.

For antenna calculations, all feeds are normally excited.  However, for S-Parameter
calculations only one feed can be excited for a particular FDTD calculation.  If an S-
Parameter calculation is to be made, the "yes" option next to the S-Parameter
specification box must be selected.  Also the active port must be entered as well for this
particular calculation.   XFDTD then provides that column of the S-parameter matrix. 
For example, if port 1 is excited in a 3-port circuit, XFDTD will determine S11, S21, and
S31.  If different ports are to be excited, a separate FDTD calculation must be performed
with the another port active. For example, if the full S-parameter matrix for a 2-port
problem is desired, two calculations must be performed with a different port active in
each.  The Project file should be saved with the same name in each case.  XFDTD will
save the S-parameters for each run in separate files differentiated by the active port
number.

9-1-2 Plane Wave

The second stimulus form available is the incident plane wave.  Calculations of Radar
Cross Section or scattering may be performed using this input.  The plane wave source
is assumed to be infinitely far away.  All calculations with the incident plane wave input
are performed in SCATTERED FIELD.   Total field values may be saved and displayed
as they can be determined by adding the specified incident field with the computed
scattered field.  

The incident plane wave is specified using the menu shown in Figure 34.   The incident
direction defined by phi and theta must be specified in degrees.  Phi is measured from
the X axis to the Y while Theta is measured from the Z axis to the XY plane (see the
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Figure 34: The incident plane wave menu.

Figure 35: The TEM excitation menu.

coordinate system in Chapter 3.  The incident waveform may be Phi or Theta Polarized. 
The electric field values in the X, Y, and Z directions are displayed on this window and
are updated each time the polarization or incident direction is modified.

9-1-3  TEM Excitation Plane

The final excitation choice is the TEM Excitation Plane (Figure 35).  This is a very
specialized excitation option, and may only be used with a special class of geometries. 
This option is designed to excite a Transverse Electro-Magnetic mode in the FDTD
space, and requires a suitable geometry for propagating such a mode.   A typical TEM
geometry will have two to four parallel walls of the FDTD space set to perfect conductor
(see the section on the Outer Radiation Boundary Types) and should have some type

of center conductor. 
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Figure 36: The waveform menu.

An example TEM geometry might be a coaxial cable with square outer conductor
(defined by setting PEC Outer Radiation Boundary Types) and an inner conductor.  
Multiple inner conductors are acceptable.  XFDTD will set up the TEM mode excitation
assuming that the outer conducting walls are at ground potential and the inner
conductor(s) are all at the excitation potential.

A plane perpendicular to the conducting walls must be specified on the TEM Excitation
Plane window.  The electric and magnetic fields of the TEM mode will be excited in this
plane.  The excitation plane is typically located a few cells from the end of the geometry
but may not be closer than 4 cells from the absorbing boundary.  Normally, the
propagation direction is into the geometry.  The TEM wave will propagate in the
positive coordinate direction from the excitation plane, so a typical selection for the
slice number is "5".  The calculation of the TEM-mode fields may be verified by
pressing the "preview fields" button and viewing the geometry in the appropriate slice
plane.  The electric field vectors tangent to perfect conductors should be zero, and
should be directed away from (normal to) the conducting surfaces. 

9-1-4 Specifying the Source Waveform 

Regardless of whether the excitation is a plane wave, near zone feed, or a TEM mode,
the time variation of the excitation must be determined.  The Set Waveform button in
the upper-right corner in each of the stimulus definition windows controls this.  Pressing
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the Set Waveform button brings up this window. (Figure 36)

The excitation for the FDTD calculation may be a Gaussian pulse, a Gaussian
Derivative pulse, a Modulated Gaussian pulse, a Sinusoid, or “user defined” in which
case a custom waveform may be supplied.  The choice of the excitation should be
based on the desired output results as some excitations are more appropriate than
others.  The Gaussian pulse provides a broadband input and is suitable when results
versus frequency are desired.  The derivative Gaussian is nearly identical to the
Gaussian except that the DC component is removed.  This is useful for calculations
where a short-circuit loop exists since the regular Gaussian could excite DC current
flow which would affect the quality of the output.  The modulated Gaussian is used
when only a specific frequency range is desired.  This is very useful in structures where
low frequencies could excite non-radiating modes which could resonate and destroy the
results.  The sinusoidal input is useful when only one frequency is of interest.  There
are numerous output choices available with the sinusoidal input as well.  

Depending on which waveform chosen, the appropriate parameters of the excitation are
available for selection.  The pulse width is the number of timesteps between the half-
amplitude points on the Gaussian pulse input.  For a Gaussian modulated pulse there
is a Gaussian envelope of the specified pulse width enclosing a sine wave of the
specified frequency.  The sine wave is centered in the Gaussian envelope so that the
average value of the pulse is zero.  The two graphs in this window show the time
variation and frequency spectrum of the waveform to aid in correctly specifying the
parameters.

When choosing the pulse width and/or frequency, bear in mind the constraints of the
FDTD method.  The time rate of change of the pulse (maximum frequency with
significant energy) or the sine wave frequency must be chosen low enough so that a
sufficient number of time steps occur during one period for reasonably accurate
sampling.  The Courant limit for the time step size is where x is the size of the cell
edge, t is the time step, and c is the speed of light.  Assuming the often applied
constraint that x< /10, the maximum frequency specified is then constrained by:

The default size for the Gaussian pulse width is 32 time steps. This provides a
reasonable frequency bandwidth for the Gaussian pulse.  For the Gaussian derivative
pulse the time duration should be set somewhat greater since the Gaussian derivative
pulse will have a higher frequency spectrum than a Gaussian pulse of the same time
duration.  



58

'

f
max

& f
min

2

2

2
@ 20

x ln 10

'

4

( ) t

The pulse width for the modulated Gaussian may be adjusted to enclose a specific
frequency range.  This may be useful, for example, in waveguide calculations so that 
only frequencies in the band of single-mode operation are excited.  Another useful
situation is when band-limited devices are being analyzed.  For example, a broadband
antenna, such as a spiral, may be designed for a specific frequency range.  Exciting the
antenna at frequencies outside this range may greatly increase the number of time
steps need for convergence, since the out-of-band energy cannot readily radiate or be
otherwise dissipated by the antenna structure.

In order to set the frequency spectrum of the modulated Gaussian excitation fmax is
defined as the highest frequency of interest (in Hz) and fmin as the lowest frequency,
and t the time step.   In XFDTD the modulated Gaussian frequency is then (fmax -
fmin)/2.  The Gaussian envelope varies as exp{-  t2)}.  To find where the specturm of the
modulated Gaussian is down x dB from the pak at frequencies fmax  and fmin, the
expression  

is solved.  Once  is determined from this expression the pulse width  in time steps
(used in the XFDTD menu) is given by 

where t is the time step in seconds.

For example, with fmax = 19 GHz and fmin = 11 GHz, and the attenuation of the
spectrum at these frequencies is x = 60 dB and the time step t = 1.059 ps the
modulated Gaussian frequency is 15 GHz, and the pulse width in time steps is 789.

Note:  The pulse width should not be so short as to introduce energy at frequencies too
high for the FDTD method to produce accurate results, nor so long so that the
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calculation is not excited at frequencies for which accurate and useful results might be
obtained.  There must be sufficient energy in the pulse for calculations to be above the
numerical noise for all frequencies of interest.   For calculations with very small cells
compared to the shortest wavelength of interest, pulse widths may be set much larger
than the default size to reduce the number of time steps needed for convergence and to
increase stability. 

If dielectric materials are present, the wavelength will be reduced inside the material
and the velocity of propagation will be less than the speed of light in free space.  A
reasonable rule to apply is that the maximum frequency for the spectrum of the
excitation pulse should be reduced by the square root of the relative permittivity, or
equivalently the pulse width should be increased by this factor.   This assumes lossless
or low loss dielectric.  For more lossy dielectrics or conductors, the frequency and pulse
width should be adjusted proportionally to the change in velocity and wavelength in the
material relative to the free space wavelength.  Of course the maximum frequency for
reliable results is also reduced as the frequency spectrum of the excitation pulse is
reduced.

For example, suppose part of the calculation space is free space and part is a low loss
dielectric with relative permittivity 4.0  Further suppose the cell size is 1 cm.  At 10 cells
per wavelength, one would expect reasonable results up to 3 GHz with a Gaussian
pulse 32 time steps wide.  But since part of the space has the dielectric material, with
the same cell size the Gaussian pulse width should be increased to 64 to reduce the
frequency spectrum bandwidth.  Correspondingly, the maximum frequency for reliable
results would be decreased from 3 to 1.5 GHz.

Note: When the pulse width is changed from the default values, the FDTD results for
some frequencies will not be valid since the energy spectrum of the modified pulse will
not excite the problem over then entire spectrum.  When displaying such results limit
the frequency range accordingly.

When choosing the source form, remember that the Gaussian pulse has a non-zero
average value.  It should not be used for calculations if there is a closed path (loop) of
perfect conductor connected to the electric field location unless a source resistance is
also specified.  This is because a steady current will start to flow in the loop and never
decay through loss or radiation.  The symptom of this will be a source current that has
an average value not equal to zero.  If this occurs, the Gaussian Derivative or
Modulated Gaussian pulses can be used or a non-zero source resistance included in
the calculation.

An arbitrary source voltage vs time my be specified by choosing User Defined from the
Stimulus Waveform window.  Pressing this option will open a menu asking for the
input filename with an extension .src.  The file format for a user-defined waveform is
as follows: the first line must be an integer which is the number of time steps in the
waveform, additional timesteps will be zero-padded.  The format of the rest of the file
depends upon whether a voltage source  or incident plane wave calculation is being
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made. For a voltage source excitation each following line, one for each time step,
contains two floating point number representing the voltage and its time derivative at
the feed at that timestep.  For an incident plane wave calculation, each following line,
one for each time step, contains two floating point numbers.  The first number on each
line is the electric field value, in Volts/meter, at each time step, and the second is the
time derivative of the electric field of the incident plane wave.

9-1-5 Number of Time Steps

For each of the different types of Stimulus, a number of time steps for the FDTD
calculation must be specified.  This number must be chosen with care since a low
number will terminate the calculation before convergence of the results is obtained.  A
high number will cause unnecessary calculations to be performed, but will not result in
errors.  XFDTD will display an error message if the number of timesteps entered is too
small to include the input waveform, but this number is far lower than the actual number
of timesteps required by the calculation.  

For a transient calculation, the number of timesteps should be large enough for all
fields to decay to zero.  This can be checked by making a calculation and observing the
transient field results by sampling near-zone field points.  For a sinusoidal excitation,
sufficient time steps to reach steady-state must be chosen.  Again, near-zone values
should be saved and observed so ensure that the system has reached steady-state.  

Results that require the application of an FFT (any results which will be displayed
versus frequency), or that assume steady-state sine wave conditions have been
reached (such as antenna efficiency or steady-state far-zone transformation) will not be
accurate if sufficient time steps to not been specified.   It is vital that the near-zone
results be observed to determine convergence before attempting to make conclusions
about the output of a calculation.

Note: The only way to be ensured of convergence of the FDTD calculation is to view
the time records of near-zone field values or the feed point current/voltage.  XFDTD
does not send an error message when an insufficient number of timesteps have been
calculation.  The determination of convergence or steady-state is left up to the user and
is best viewed by plotting near-zone field values.

9-1-6 Far Zone Transformation for a Sinusoidal Source

In  the Sources/Loads and Plane Wave Run Parameter sub-menus there is a choice for
the Far-zone transformation type for a sinusoidal input (Figure 33).  If a transient input
(gaussian pulse etc) is chosen, this option will not be available.  The choices for the far-
zone transform are between Transient, Steady-State, or None.   Typically this option
should be selected as “Steady-State” since this offers the most flexibility.  However, if
only near-zone values are of interest such as in an S-parameter or SAR calculation,
selecting “None” will save a small amount of calculation time and a sizable amount of
disk space.  In some instances, the transient far-zone calculation may be desired and
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Figure 37: Sample Near-Zone Data menu

so that choice is available.  This will require that far-zone angles also be specified
using the Transient Far-Zone Angles menu and useful results will only be available at
the frequency of the input.  

Note:  The Far-Zone Transformations are not valid if any of the outer radiation
boundary conditions are set to PEC or PMC, or if any material is within 6 FDTD
cells of the outer boundary.

The steady-state far-zone transformation does not require the definition of specific far-
zone angles before the FDTD computation.  Instead, the FDTD calculation saves the
tangential electric and magnetic fields on the far-zone transformation surface at two
time steps near the end of the calculation when the system should be in steady-state. 
This sampling determines the complex tangential fields on the far-zone surface at the
excitation frequency.  These fields are then used in post-processing (under the Results
menu) to provide radiation gain or bistatic scattering in any far-zone direction at any
pattern increment.  This saves considerable computer time and memory if many far-
zone directions are required. 

The selection of a Steady-State Far-Zone transformation also computes the  the single
frequency input impedance, total input power, radiated power, and antenna efficiency.  
All values computed require that the calculation has reached steady state.  XFDTD
does not evaluate calculations for convergence or steady-state though and so near-
zone values should be observed to ensure these conditions exist. 

9-2  Sample Near-Zone Data

With the Sample Near-Zone
Data menu (Figure 37),
transient near-zone field
quantities at specific points
within the bounds of calculation
space may be saved.  The field
quantities of X, Y, and Z-
directed electric and magnetic
(E and H) fields may be saved
as well as the X, Y, and Z-
directed current density (J). 
Current densities are
determined by multiplying the
conductivity of the material at
the specified cell location by
the Electric field in the given
direction.  When a PEC
material is present, the current density will be computed by the loop of magnetic fields
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Figure 38: Transient Far-Zone Angles menu

surrounding that cell edge.  Thus, the current density only includes the conduction
current.  When a near-zone or TEM source is used as the input, the total field values
are available.  With an incident plane wave input, the scattered and total electric and
magnetic fields may be saved in addition to the total current density.    

The location of the field quantity must be specified by its X, Y, Z location in the
geometry grid.  If subgrids exist, the desired grid must also be specified.

Note: Near-zone fields in the main grid may not be saved in areas covered by a
subgrid.  The subgrid fields overwrite the main grid fields, so saving the subgrid field
provides the same information as saving the main grid field.

Note: The location of a near-zone quantity may be specified simply by positioning the
mouse on the desired cell edge and pressing the right mouse button.  Choose Save
Data from the popup menu.  This will open the menu shown in Figure 37.  

Each quantity added to the list at the bottom of the window will be saved by the
calculation program.  The output will be a file containing the time and the near-zone
quantity.   After the entire calculation is complete, these files may be displayed in
XFDTD with the plotting features.

9-3 Transient Far-Zone Angles

The Transient Far-Zone Angles menu
(Figure 38)  is used for specifying far-zone
directions with a transient input.  When a
steady-state far-zone has been selected
from the input menu, this menu is not
available and is not needed because all
far-zone directions are available in
postprocessing in that case.  However, with
a transient input, the far-zone directions
must be specified before the calculation
with this menu. 

The far-zone directions must be specified
as angles in spherical coordinates.  The
same coordinate system shown in Chapter
3 and used for specifying the incident plane
wave direction is used here.  

With Single Far-Zone Angle only a value for Phi and Theta in required.  This is useful
for cases where only one far-zone direction is of interest, such as in back-scattering
calculations. The angle will be added to the list only if it has not been specified
previously.
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Figure 39: Planar Transient Fields menu

Constant Theta Pattern is used for a specifying series of angles at a single Theta
direction.  The starting and ending Phi angles must be entered as well as an increment. 
A Constant Phi Pattern may be specified for patterns that vary with Theta. 

Transient far-zone angles add a noticeable overhead to the FDTD calculation both in
terms of memory and execution time.  Care should be taken to specify only those
angles where are required.  If a detailed pattern is required, another option is using the
steady-state far-zone transformation.  The steady-state far-zone transform only
provides a pattern at the input frequency, but patterns in any direction at any resolution
may be computed in postprocessing. 

9-4 Planar Transient
Fields

The Planar Transient Fields window
(Figure 39) is used for saving
“movies” of fields in specific planes of
the geometry during the FDTD
calculation.  The principle plane (XY,
YZ, or XZ) must be specified along
with the slice number (ie Z=25) and
the grid (if subgrids exist).  The
starting, ending and increment values
in timesteps must be entered as well. 
A field file containing the electric and
magnetic fields and the current will be
created for each timestep specified. 
For example, setting the entries to
Z=25 beginning at timestep 100,
ending at timestep 1000, with an
increment of 100 will create 10 field files which may be viewed as a movie after the
FDTD calculation is performed. 

Note: Great care should be taken when specifying the number of field slices to save as
they can store enormous amounts of data.  Single field files may contain megabytes of
data depending on the number of cells in the specified plane.

If field slices are to be saved in subgrids (if present), note that the timestep in a subgrid
is 1/3 or 1/5 the size of the timestep in the main grid. 

9-5  Single Plane Steady-State Data

The windows for saving the different steady-state quantities are quite similar.   The
window for saving SAR quantities is shown in Figure 40.  The steady-state quantities
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Figure 40: The Save SAR Data menu. 
The menus for saving steady-state E-
fields and B-fields are similar.

Figure 41: The menu for saving steady-state conduction current
magnitudes and surface currents.

available are: Specific Absorption Rates (SAR), sinusoidal peak electric field
magnitudes (EFM), magnetic flux density (B-field) magnitudes (BFD), and conduction
current magnitudes (CCM).  An example of the Save Conduction Current Magnitudes
is shown in Figure 41 .  It is slightly different from the windows for the other steady-
state quantities, basic choices on the window are the same.  Note that these choices
are only available with the BioPro version of XFDTD.

For each steady-state quantity, the choice is to
save data in a specify slice plane of the
geometry.   These menus are useful if steady-
state data is desired in one particular plane. 
However a more useful choice is often the All
Plane State-State Data menu which is
discussed later.  

Steady-state values for SAR and conduction
currents will not exist in all planes as they
require lossy dielectric material.  Saving the SAR
in a plane of free-space will not produce any
useful output as all values will be zero.  The E-
field and B-field magnitudes may be saved in any
plane of the geometry though.  

Note: To save the
steady-state quantities
in a particular slice of
the geometry, simply
press the right mouse
button in the desired
slice plane of the
geometry window and
choose Save Data
then Steady State
from the popup menu.  

9-5-1 Saving 3-D Surface Currents

Surface currents may be saved over entire geometries or over specific portions of a
geometry.  To save Surface Currents, in the Save Conduction Current Magnitudes
window (Figure 41), pick Surface in the Plane box.  Select the grid (if subgrids are
present) and specify whether the surface currents should be saved over the entire



65

SAR '

x

x

| E
x

|
2
%

y

y

| E
y

|
2
%

z

z

| E
z

|
2

geometry or only in a specific sub-region.  If the sub-region choice is selected, enter the
extent (in cells) of the sub-region in the spaces provided.  

9-5-2 Specific Absorption Rate (SAR)

For FDTD calculations SAR is defined for each FDTD cell as

where Ex is the root mean square (RMS) amplitude of the X component of the
sinusoidal electric field in a particular FDTD cell, x is the corresponding conductivity in
S/m, and x is the corresponding material density in kg/m3 .  The remaining two terms
are for the Y and Z components of the same FDTD cell (same I,J,K values in the mesh). 

The conductivity values used by XFDTD are those entered in the material parameter
menu.  The code does not convert complex permittivity values (such as from frequency
dependent materials) into conductivity terms.  The SAR calculation is a only valid with a
single frequency input, so only normal dielectric materials should be specified.  If
material parameters are given in as complex permittivity, the static conductivity can be
computed as

σ ωε ε= o o ’’
where o is the radian frequency desired.

The SAR (by definition) uses RMS electric field values, but the electric field, magnetic
field, and conduction current density magnitudes are saved and displayed as peak
values.  These steady-state quantities are available only if sinusoidal excitation is
chosen.  Check near-zone values ensure that steady-state has been reached in the
calculation.  If not, increase the number of timesteps and run the calculation again.

In XFDTD 5.0 the SAR is formed from the 12 edges of the cells.  The four electric fields
in each direction are averaged to give the x, y, and z-directed fields using in the SAR
equation.    Previous versions of XFDTD formed the SAR at nodes using 3 electric
fields.  The SAR values and results in XFDTD 5.0 will vary slightly from earlier XFDTD
version results.  

Note:  If non-biological lossy dielectric materials are present (perhaps a plastic cover
for a cellular phone) setting the material density of that XFDTD material type to zero in
the Edit Material Densities” menu under Edit will cause XFDTD to predict zero SAR for
that material.
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9-6  All Plane Steady-State Data

The All Plane Steady-State Data menu should be used when any of the Steady-State
quantities are desired in many planes.  By selecting this option, “movies” of the steady-
state quantities versus position in the geometry may be viewed in XFDTD after the
calculation is complete.   This option will also automatically select which SAR and
conduction current (CCM) planes to save based the material in the geometry in each
plane.

Note: To compute 1 or 10 gram Average SAR values, the SAR values must have been
saved in at least one direction (XY, YZ, or XZ) for all planes using the All Plane
Steady-State Data menu.

To edit the planes selected, to view the listing of planes, or to add more planes, use the 
Single Plane Steady-State Data menu described in the previous section.   If the All
Plane menu is used, the steady-state sequence files for that particular quantity will be
computed automatically. 

Note: In previous versions of XFDTD, the average SAR calculation was performed in
post-processing.  This function must now be defined before executing the calculation
program using the All Plane menu.  Select All Plane Steady-State Data->1 (or 10)
Gram Averaged SAR from the Edit menu and then select the desired direction.

9-7  Compute Input Impedance

If the transient far-zone transformation has been selected, the input impedance versus
frequency may be computed for the first voltage source.  To do this, select the
Compute Input Impedance option (Figure 42).  Enter the desired FFT size on the
menu which must be larger than the number of timesteps to be computed.  Selecting a 
larger FFT size will provide more sample points of the impedance in the frequency
domain.  This will result in a smoother impedance plot.  The input impedance is
determined as the complex FFT of the total source voltage divided by the FFT of the
total source current at each frequency.  This input impedance will include the effects of
the other feeds if any have been specified.  Voltage and current samples beyond the
number of time steps specified for the FDTD calculation will be set to zero.  Input
impedance for each source feed is always available if steady state far zone
transformation is selected.

Note:  If Steady State far zone transformation has been selected the single frequency
input impedances for each source are always calculated and the Compute Input
Impedance menu choice is not active.  The input impedance is displayed from the
Steady State Antenna Data entry of the Results menu.  Again, this input impedance is
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Figure 42: Menu for entering the FFT size for the
input impedance. 

the total complex voltage divided by the total complex current, and therefore includes
effects of other feeds if they exist.  

9-8  Adjust Time Step

This menu item may be used to reduce the timestep in the FDTD calculation.  The time
step size is determined automatically by XFDTD and normally should not be modified. 
Situations may occur where this control is desired.  One situation may be where a
frequency-dependent dielectric or magnetic material is specified with parameters that
cause instability in the FDTD calculation.  This instability may sometimes be removed
by reducing the time step.   The timestep may also be reduced when the impedance or
antenna gain is needed at a specific frequency.  Reducing the timestep may adjust the
FFT bins so this frequency may be selected.

Note: It is not recommended that the tmestep size be modified except in cases where it
is absolutely necessary.  Modifying the timestep size can lead to incorrect results or
instabilities in the calculation.

The time step is specified as a fraction of the maximum (Courant limit) time step in the
main grid.  The Courant limit may not be exceeded nor can a timestep of 0 be entered. 
If subgrids or anisotropic ferrite materials have been specified will automatically be
reduced below the Courant limit by XFDTD. 

9-9  Selecting Outer Radiation Boundary Conditions
The default boundary condition for XFDTD is a second-order, stabilized Liao radiation
boundary.  This is a numerical absorber designed to allow electromagnetic fields
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Figure 43: The menu for setting the outer radiation
boundary condition.

radiated or scattered by the FDTD geometry to be absorbed with very little reflection
from the boundary.  The Perfectly Matched Layers (PML) outer boundary is also
available (see Figure 43).  The Liao and PML boundaries may not be mixed together in
the same calculation.  Furthermore, PML may not be used with the Perfect Magnetic
Conductor (PMC) boundary, while Liao may be used with both Perfect Electrical
Conductor (PEC) and PMC boundaries.

Note: XFDTD treats the specification
of the outer boundary as a
calculation parameter, not a
geometry feature.  Thus the outer
boundary specification is stored in
the XFDTD project file, not in the
geometry file.  A conducting outer
boundary will not be evident in the
geometry view until the project file
has been loaded.

9-9-1 Liao Absorbing Boundary Type

It is important to understand the differences between the Liao and PML options.  Liao is
an estimation method. By looking into the FDTD space and back in time it estimates the
electric fields just outside the limits of the FDTD mesh.  These estimated values are
then used in the FDTD equations inside the space.  The Liao estimation is made
assuming that waves are allowed to travel outwardly from the space but not reflect back
in.   The Liao method works well provided that there is enough space between the
radiating geometry and the outer boundary.   Typical limits are at least 15 cells spacing. 

A homogeneous dielectric may be located up against the Liao boundary.  For example,
in a lossy earth or stripline calculation, the earth or dielectric layer may touch the outer
boundary.  Liao will usually function well in this situation, provided that there are no air
gaps within 5 cells of the Liao boundary.  Liao assumes homogeneous material within 5
cells, and if this is not the case then the FDTD calculation will usually be unstable with
rapidly rising field amplitudes.  
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Since Liao is an estimation method, the size of the FDTD mesh is not increased by
using it.  Some storage is needed for saving electric values at previous time steps, but
this is usually negligible in a typical calculation. 

9-9-2  PML Absorbing Boundary Type

PML is an artificial absorbing material.  It absorbs the incident energy as it propagates
through the PML layers.  Better absorption, that is, smaller reflection, is obtained by
adding more layers at the expense of increasing the size of the FDTD mesh.  For
example, consider an FDTD calculation on a mesh using the Liao absorber that is 50 x
60 x 70 cells or a total of 210,000 cells.  There is a 15 cell free space border all around
the geometry so that the Liao boundaries can provide small reflections.  If the Liao is
changed to 8 PML layers, the geometry mesh will not change However outside of this
defined mesh region, 8 additional FDTD mesh layers are added on each side of the
geometry.  This means that the actual number of FDTD cells that must be calculated
grows to 66 x 76 x 86 or 431,000 cells, more than double.  Since PML cells require
more arithmetic operations than normal FDTD cells, the time penalty is actually greater. 

This time penalty for PML is also increased since the PML cells have special equations
for both electric and magnetic fields.  For an FDTD calculation with no magnetic
materials present the magnetic fields are computed very quickly.  However, when PML
is added the magnetic field update equations are more complicated even when no
actual magnetic fields are present and this adds to the time penalty.

Benefits of PML

It may be that the PML layers might provide better absorption than Liao even with only
a 5 cell border of free space.  And perhaps only 6 PML layers would provide this. So in
such a situation calculation time would be saved.  Making this comparison would
require meshing the object again with less free space margin to the outer boundary. 
This can be done in XFDTD using the mesh merge function.  

Both PML and Liao are offered to provide flexibility.  Both methods should provide
similar results when properly used. 

9-9-3 PEC (Perfect Electric Conductor)

Radiation and scattering calculations require that all six outer boundaries be set as
absorbing.  In some situations there are advantages terminating one or more faces of
the FDTD geometry space with a perfect electric conductor (PEC).  For example. the
conducting ground plane of a microstrip could be located on one face of the FDTD
space.  
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A special utilization of this capability involves setting four of the FDTD surfaces to PEC
forming a rectangular conducting tube.  These may be considered as the outer walls of
a Transverse Electro-Magnetic (TEM) cell.  If a center conductor along the length of the
tube is then added, a TEM wave can propagate along the tube and be absorbed at
either end in the two remaining absorbing boundaries.  This geometry is useful in
making calculations of the electromagnetic fields inside a TEM exposure cell.  To excite
the TEM wave inside such a geometry a special menu item in the FDTD menu allows
for the TEM mode for any conductor geometry which includes at least one conducting
FDTD wall and one other conductor to be generated and used to excite the FDTD
calculation.  

If the outer boundary of the calculation is not free space, a plane wave should not be
used to excite the calculation, and the far zone transformations will not provide
accurate results for far zone fields.

Note: An edge of the FDTD space should be set to PEC using the PEC Boundary
Condition.  DO NOT set FDTD cells to PEC material in the geometry and set the outer
boundary to Absorbing as this will cause instabilities in the calculation.

9-9-4 PMC (Perfect Magnetic Conductor)

The final choice of outer boundary is PMC, that is, perfect magnetic conductor.  This
may be useful in taking advantage of geometry symmetries to reduce the size of the
FDTD mesh and therefore the memory and calculation time required.
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Figure 44: The Results menu.

Figure 45: The field control
panel.

10 Results Menu

The interface to the FDTD calculation
program and the numerous options for
processing  the output from an XFDTD
calculation are found on the Results menu 
(Figure 44) of the Run Parameters window. 
After all parameters for an FDTD calculation
have been entered and saved, selecting
Results/Run CalcFDTD will begin the
simulation.   After all timesteps have been
calculated and the output files have been
written, some post-processing option may be
available on this menu.   Not all choices will
be available on this menu as the post-processing depends on the input parameters and
data saved during the calculation.  All of the possible choices and when they are
available are described in this chapter.

10-1 View Fields

Several choices for color intensity displays are available in XFDTD.  After field file of
the appropriate type is loaded, this menu choice will become available.  In XFDTD 5.0,
this menu is activated after loading either a planar transient field file or sequence, or
any one of the steady-state data files or sequences such as SAR, electric field or
magnetic flux densities, or conduction currents.   The time-domain field files will display
either the electric or magnetic fields, the current density or Poynting vector in a single
slice of the geometry at various moments in time.  The steady-state quantities files are
magnitudes in specific planes so the sequences slice through the planes of the object
rather than through time.  Both the time-domain and steady-state sequences are
available immediately after the FDTD calculation finishes (if the All Planes option was
chosen for the steady-state data).

Each different type of field display has a different menu
for controlling the fields.  The View Fields menu for a
Planar Transient Fields Sequence File is shown in
Figure 45.  This menu is used for controlling the
display of the transient color intensity file snapshots in
the two-dimensional time domain cuts through the
FDTD space that were selected prior to the calculation. 
Choose the field component to display from this menu. 
Choices are electric or magnetic field vector
components, current density components, total electric
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Figure 46: The Set Full Scale window for a time-
domain field file.

or magnetic field or current density amplitudes obtained by combining all three field
vector components, and Poynting vector components.
   
The color intensity areas are the same size as one FDTD cell face when using the
Quick Draw Fields (Preferences menu).  Otherwise the fields of neighboring cells are
interpolated to create a smoother field transition.   The display is centered on the
spatial location of the current field component.  Some quantities, such as total electric
or magnetic fields or steady-state SAR, involve three vector components.  For these the
color intensity area is centered on the spatial location of the field component normal to
the viewing plane.

The fields may be displayed on either a linear or dB scale.   The default is the dB scale
with 3dB separating each color on screen.  When the scale is set to linear, the step
defaults to 20% between adjacent colors so that the red (highest intensity) represents
100% and blue represents 20%.  The display colors are graduated, so that a color
intensity between yellow and red would indicate a field magnitude between those two
levels on the color bar.  Since FDTD is spatially discrete, some volumetric quantities
may be offset by a fraction of an FDTD cell since the quantities from which they are
calculated are not co-located in space.  

Initially the fields are automatically normalized to the peak value in that plane.  With
each new field file loaded, the peak value, and thus the scale, changes.  With
sequence files, the peak value for all files is used as the normalizing value.  However,
for additional flexibility the Set Full Scale (Figure 46 and Figure 47) option may be
used to force a certain peak value on the display.   This is useful if small regions of the
field display region, such as near the antenna feed, have very intense field levels.  For
display purposes, all values greater than the Full Scale value are displayed as if they
were equal to the full scale value. 

The normalization value is displayed
with the fields and can be found at the
lower left corner of the field image in the
geometry window.  The peak value is
the 0 dB or 100% number while the
other colors are based on field values
related to this peak.    The mouse
pointer may also be used to find the field
value at a specific location in the
geometry.  Move the mouse pointer over
the geometry image while a field is
loaded and the field is displayed in the
geometry window.
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Figure 47:   The Set Full Scale menu for an SAR
file.

Any of the transient field files or steady-
state quantities listed in the sequence
file may be displayed individually or
XFDTD can automatically run through
any set or subset of the files listed in
the sequence file.   The sequence can
be viewed as a looping movie by
pressing the PLAY button.  For a time-
domain field sequence, this movie will
display the field propagation over time. 
For a steady-state quantity sequence,
the movie will show slices through the
geometry.  The other functions
available include the frame advance, fast forward, rewind, move to end, and move to
beginning.  The sequence can be modified to only play over a certain portion by setting
the starting and stopping frame numbers.  

To clear the field display, click on the Clear button of the Field Control menu.  This will
remove the fields from the screen and close the Field Control window.

When a steady-state SAR file or sequence has been loaded, an additional capability
the option to adjust the input power.  If a specific input power is desired, this value can
be entered and the SAR fields display will be scaled accordingly.  This feature is
accessed through the Set Full Scale button (see Figure 47).   The computed input
power will be displayed along with a window for setting the desired input power.  

Three-Dimensional Surface Current Display

The display of currents flowing on a three-dimensional surface is somewhat different
than the planar display of SAR, fields, and currents discussed previously.  The file
containing the surface currents (of extension .ccms) is grouped with the Conduction
Current Magnitudes on the Project Tree.  Once this file is loaded, the Field Control
window can be opened as with planar files.  For best results, the 3D viewing option
should be selected. 

Capturing XFDTD Screen Views

With the Windows version of XFDTD, there are two options for capturing screen views. 
On the geometry window, select View/Export Bitmap to save the image in the geometry
window.  This image may be the geometry alone or the geometry with fields.  A second
option is to simply press the Print Screen button which will capture the active window in
a buffer.  This image may then be pasted into other software such as the Windows
Paint program.



74

In Unix XFDTD does not include the capability to provide users with digital files of
XFDTD displays directly.  However, other software exists that can do this very well. 
To obtain digital images (.gif or .tif files or other formats) of any of the XFDTD screen
images we recommend the free software xv.   It can be obtained over the Internet by
anonymous FTP to ftp.cis.upenn.edu.  The xv software is available from directory
pub/xv.  Executable versions of xv for many systems can be obtained using a web
browser from www.trilon.com/xv/downloads.html#distributions.  Additionally, the Unix
XFDTD screen can be exported to a Windows machine using an X-server and images
may be saved using the Print Screen method described above.

10-2 Display Plot

Plots of most data saved by XFDTD can be displayed with the plotting tools included
with the program.  The plotting tool may be opened either through the Display Plot
Results menu or from the icon on the button bar.  The Display Plot window (shown in
Figure 48 ) will then open and a plot of the desired data can be made and viewed.

There are three basic categories of plots in XFDTD, depending on the X-axis
(abscissa) type.  The first category is for time-domain plots which includes near-zone
field values, port/feed voltages and currents, and far-zone electric fields.  The next
category is for plots versus frequency for data such as input impedance, S-parameters,
gain or radar cross section (RCS), input/incident power, or port power.  Finally, plots
versus angle may be viewed for gain or RCS patterns versus azimuth or elevation.
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Figure 48: The Display Plot tool in XFDTD 5.0 on a Windows computer.

After selecting the basic plot category of interest, a listing of the available plot data is
displayed in the Data To Plot area.  Selecting one of these choices with the mouse will
cause the corresponding options to become available.  The options depend on the type
of plot.  As an example, selecting the Input Impedance versus frequency choice will
make the options Real and Imaginary active.  Any of the active plotting options may be
selected and then the data can be added to the list of plots by pressing the Add to Plot
button.  If a mistake is made, the undesired plot should be selected with the mouse
from the Data to Plot area and then pressing the Remove from List button will remove
it.  For a completely new plot, press the Remove All Plots button.  Changing the X-axis
type will also remove all plots from the list.
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Figure 49: The labels window on the Display Plot wizard on Windows.

The Windows version of XFDTD 5.0 uses a wizard for entering the plot data.  So, after
entering all the desired plots to the list, press the Next button to view more options (see
Figure 49) or to display the plot.  The next screen will display windows for entering
legends and line types for the data and labels for the axes.  The maximum and
minimum X and Y axis values can be defined or set to automatic (default) which will
scale according to the data.   There are also options for setting the location of the

legend, drawing grid lines, and axis tick marks.  Display the plot by pressing the Finish
button.



77

Figure 50: The Plotting tool in XFDTD 5.0 on a Unix computer.

In Unix XFDTD, the same options as mentioned above are accessed through the Edit

Plot Parameters and Labels buttons (see Figure 50).  The plot is displayed by
pressing the Generate Plot button and closed by pressing the Close Plot button.

Note: To set the axis value back to automatic, simply type an ‘a’ in the axis range
window. 

Note: There is currently not a function for printing plots from XFDTD.  All of the data
from a calculation of XFDTD is stored in ASCII files which can be loaded into a third-
party plotting package such as Gnuplot for printing.    The filenames and formats of the
data files are described in a later chapter of this manual.

10-3 Compute Far-Zone Data

XFDTD has the ability to compute both a transient and a steady-state far-zone (near-to-
far) transform.  The basic purpose of the transform is to generate gain or scattering
patterns in the far-zone from the near-zone field data.  There are some important
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Figure 51: The Compute Far-Zone Data
window for a Transient Far-Zone
calculation.

Figure 52: The Compute Far-Zone Data window
with a Steady-State calculation.

differences in how this is done between the two cases though.  The far-zone angles for
the desired pattern must be specified before the FDTD calculation for the transient far-
zone transformation.  In post-processing, a gain pattern versus angle can be generated
at the angle specified.  The pattern can be made at any frequency in the input or at a
single angle over all frequencies in the input (see Figure 51).  The steady-state far-
zone transformation is only available at the frequency of the input, but no angles need
to be specified before the calculation and in post-processing a pattern can be made at
any set of angles in any increment (see Figure 52).    

Because of the inherent differences between the transient and steady-state transforms,
the menu that appears when the Compute Far-Zone Data option is pressed will have
slightly different choices.   The transient far-zone menu, shown in Figure 51 has four
options at the top for selecting the type of transform.  If the Plot vs. Frequency or far-
zone electric field option is selected, all of the available far-zone angles will be
displayed in the angles window.  For a plot versus theta or phi, the available angles will
be shown in the angles window and the list of FFT frequency bins will be shown in the
Frequency window.   The FFT size may be modified for a higher resolution graph. 
Multiple far-zone calculations may be made at a time simply by adding to the list. 
Pressing OK will start the post-processing calculation.

When the steady-state far-zone is selected, the Compute Far-Zone Data menu is
simplified.  A pattern made be computed versus Theta or versus Phi.  Select one of
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these options and then set the fixed angle, the starting and stopping angles and the
increment.   For example, for a pattern versus Theta from 0 to 180 in 1 degree steps at
Phi=45, set phi to 45, theta to 0, theta final to 180 and increment to 1.    As with the
transient far-zone, multiple patterns can be made at a time simply by adding more on to
the list.  Pressing OK starts the post-processor.

Note: As with all steady-state calculations, accurate results can only be obtained if the
system has actually reached steady state.  Sufficient timesteps must be specified and
near-zone values monitored to ensure that there are no transients in the system.

Far zone calculations cannot be made unless all outer boundaries of the FDTD space
are set to absorbing (Liao or PML) before the calculation of the data.  The far-zone
transformation is performed over a box 5 cells in from the outer boundary.  Therefore,
no part of the geometry may pass through this box or else invalid results will be
computed.

10-4 Compute S-Parameter Data

Whenever S-Parameter calculations are performed with transient pulse excitation
XFDTD can provide files for plotting S-parameters vs frequency.  The S-parameters will
be computed by the calculation program using the default FFT size.  However, the S-
parameters may be post-processed at a different FFT size for increasing the resolution
of the results in the frequency domain.   To do this, simply open the Compute S-
Parameter Data window and set the desired FFT size.  Press the OK button to
compute the new S-parameter data.    

Note: The S-parameters computed will depend on which port is currently designated as
active.  For example, if active port 1 is selected, than S11, S21, S31, and so on will be
calculated.  

10-5 Compute Averaged SAR Statistics

Note: In XFDTD 5.0 the SAR statistics are computed during the execution of the
“CalcFDTD” program rather than in post-processing.  This menu will perform the same
function, but it is more efficient to use Edit->All Plane Steady-State Data->1 (or 10)
Gram Averaged SARs when defining the project before executing the CalcFDTD
program.    

XFDTD 5.0 computes the Specific Absorption Rate (SAR) in each complete cell
containing lossy dielectric material and with a non-zero material density.  To be



80

Figure 53: The SAR Statistics menu.

considered a complete cell, the
twelve cell edges must be lossy
dielectric material.  With the
Compute SAR Statistics menu, the
maximum SAR in the geometry can
be found (both the value and the
cellular location) as well as the
whole body average (the average of
the SAR in all the lossy dielectric
materials).  If desired, a 1 or 10
gram averaging calculation may be
performed as well.    The maximum
1 and/or 10 gram average SAR
values and location will be located
and files of the averaged SAR will
be created for viewing.  

Note: To compute the SAR statistics, the SAR values must have been saved in “All
Planes” in at least one direction (xy, yz, or xz).

To compute the SAR statistics (Figure 53), first choose the direction.  As mentioned
above, the SAR values must be saved in all planes in at least one direction.  Choose
the direction as either XY, YZ, or XZ.   Select the desired output as either Max/Whole
body average which will only find the maximum and average SAR in the entire
geometry, or choose 1, 10 or 1 and 10 gram averaging.  With all choices the maximum
and whole body average SAR values will be computed.  

If either the 1 or 10 gram averages are selected, the geometry must contain at least
enough mass to form a valid sample space.  If the entire geometry contains less than
either 1 or 10 grams, an error message will be displayed stating that no averaging
could be performed.   If there is enough mass, the calculation will proceed.  This
averaging routine is computationally intensive and could take a significant amount of
time depending on the speed of the computer, the number of cells in the geometry, and
the density of the material.  The progress of the calculation will be displayed on the
screen to provide some feedback.

The averaging calculation uses an interpolation scheme for finding the averages. 
Cubical spaces centered on a cell are formed and the mass and average SAR of the
sample cubes are found.  The size of the sample cubes increases until the total mass of
the enclosed exceeds either 1 or 10 grams.  The sample cube increases in odd-
numbered steps (1x1x1, 3x3x3, 5x5x5 etc) to remain centered on the desired cell.  The
mass and average SAR value of each cube is saved and used to interpolate the
average SAR values at either 1 or 10 grams.    The interpolation is performed using two
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Figure 54: The SAR Statistics available after computing both the 1
and 10 gram averages.

methods (polynomial fit and rational function fit) and the one with the lowest error is
chosen.

The sample cube must meet some conditions to be considered valid.  The cube may
contain some non-tissue cells, but some checks are performed on the distribution of the
non-tissue cells.  A valid cube will not contain an entire side or corner of non-tissue
cells.  If the cube is found to be invalid, the averaging for the center cell will stop and
move on to the next cell.  It is possible (and probable) that some cells will not be the
center of an average.  However, these cells will often be part of an average cube for an
adjacent cell.  

If the FDTD cells are too large in terms of mass, the results obtained may be of lesser
accuracy.  If one cell has a mass greater than 1 (or 10) gram, an error message will be
displayed indicating this.  The interpolation will not produce accurate results for values
outside the range of sample points or when only a small number of data points is
available.

Note: To avoid computing an SAR in certain materials of the geometry, simply set the
material density to 0. 

10-6 Display Averaged SAR Information

After the SAR statistics have been computed, select this option for viewing the
results(Figure 54).  The information available includes the maximum SAR and its
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Figure 55: The Steady-State data available.

location, the whole body average SAR, and the maximum 1 and 10 gram averaged SAR
values and locations.  To adjust the SAR to a particular input power, the computed
input power is also shown.  Changing the power value will adjust the SAR values
accordingly.  This power adjustment may also be done on the Field Control Panel on
the Set Full Scale menu.

10-7 Display Steady State Data

When a steady-state calculation has been performed with a near-zone source (voltage
or current), several parameters are computed and may be viewed on the Steady State
Data menu (Figure 55).  The input impedance, input power, radiated power, and
antenna efficiency are displayed at the top of this window.  If steady-state S-parameters
have been selected, the values will be displayed in the lower part of this window.    The
values displayed on this menu are computed either when a project file is loaded or
when a steady-state far-zone transformation is computed.  Otherwise the menu will not
be available for opening.  If no steady-state far-zone transform data has been saved,
this menu will not be available.  

If more than one feed has been defined, the input impedance calculation is not
performed and will not be displayed.    When only one feed is used, the impedance is
computed by dividing the complex input voltage by the the total complex input current.

Note: If any of the boundaries have been set to PEC or PMC, or if any materials are
within 6 cells of the outer boundaries, then antenna results displayed here will not be
accurate since the far zone transformation is not valid.   S-Parameter results do not
depend on the far zone transformation and these restrictions do not apply.

If an S-Parameter calculation was made
with sine wave excitation, then this menu
will provide the single frequency S-
Parameters that have been calculated to
be displayed.  If several calculations have
been made, the results of the most recent
calculation will be displayed.  These
results are also available in ASCII files
ending in .ss.s11, .ss.s12, etc, if the user
wishes to work with the results directly.  If
more than one FDTD calculation has been
made in the same directory with the same
Project file name all of the results will be
saved in the .ss.s11, etc. files.

When an S-Parameter calculation is made
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with the steady-state far zone transformation selected, then both the antenna data and
the S-Parameter data will be displayed.  This may be useful, for example, when making
calculations for a microstrip antenna when both S11 and input impedance are of interest.
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11 User Generated Meshes

While XFDTD can be used interactively to generate complicated objects, in some cases
it is preferable to generate the meshed geometry by some other means.  This might be
by writing special Fortran or C code to generate an object that can be described by
equations, or it might be by translating an object described from another program into a
cubical mesh. 

This process is described in [7].  A material type number must be associated with each
edge of the mesh.  These material types correspond by number to those on the Material
Palettes, so that "0" is free space, "1" is perfect conductor, "2-N" are dielectrics.  In
XFDTD 5.0, the maximum number for dielectrics is 27.  If only dielectric materials are
present only one set of edges need to be defined.  If magnetic materials are present a
separate set of mesh edges must be defined.  Once the mesh has been generated, it
can easily be put into a form that can be read by XFDTD. 

Note:  XFDTD expects the geometry file to have the extension .id

An example geometry file is shown in Table 1.  The first line of a geometry file contains
the file version number.  This indicates to XFDTD the format of the file and allows for
backward compatibility.  The next line contains the variables which are the number of
cells in the FDTD space in the x, y, and z directions (NX, NY, NZ).  This is followed by
three floating point variables giving the cell x, y, and z dimensions x, y, and z in
meters.  In the example file shown, the space is 41 by 41 by 72 cells and each cell is a
1 cm cube.  The next line has three integer numbers, which are the offsets in cells of 
the geometry if it is to be used as a subgrid.  For the example file these are all zero,
since this file was meshed as a Main Grid and never used as a subgrid.  The next line
contains a flag which indicates whether or not "fuzzy" cells are used in the mesh.   No
fuzzy cells are used, and the value is zero.  

The next part of the file is organized into 25 sets of 5 lines each, one set for each of the
25 material types that can be defined.  The labels start at Material 2 since Material type
0 is reserved for free space, type 1 for perfect conductor.  The first two lines of each
material definition are used for labels and must contain the labels “emat02:” and
“mmat02:” etc exactly as shown.  The label, if defined, may be written after the
descriptor, but is best left blank at this point.   The next line holds five floating point
numbers for relative permittivity, conductivity (Siemens/meter), relative permeability,
magnetic conductivity, and material density (kg/m3).   The next line holds four floating
point numbers and one integer for defining the dispersive material parameters of static
relative permittivity, relaxation time, resonant frequency, damping coefficient, and the
integer indicating the dispersive material type (0 for normal, 1 for Debye, 2 for Lorentz). 
The last line contains five floating point numbers and one integer for anisotropic
magnetic material parameters of Lamor Precession Frequency (rad/sec), saturation
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magnetization (rad/sec), damping coefficient, theta and phi of the static magnetic field,
and finally the integer indicating the magnetic material type (0 for normal, 1 for
anistotropic).

Note: While the parameters for a material may be defined this way, it is strongly
recommended that the materials be left at the default values and the correct parameters
be set in XFDTD after loading the geometry.  

In the file shown, if a dielectric mesh cell edge is set to material type 2, this material
would have a relative permittivity of 1, a conductivity of 0. If a magnetic material mesh
cell edge is set to type 2, it would have a relative permeability of 1 and a magnetic
conductivity of 0.0.  The material density at this mesh edge for calculating SAR is 1 
kg/m3.  These parameters may be updated from within XFDTD.

At the end of the 27 material definitions, there is a line with a single integer indicating
whether thin wire materials are used in the geometry.  The zero in this line indicates
that there are no thin wires used.  If a thin wire had been specified, this number would
be a 1 andt would then be followed by four floating point numbers indicating the four
thin wire radii available (even if all four are not used).

The next four lines contain three numbers each that are the direction cosines of the
previous mesh rotation applied by the XFDTD mesh rotation module.  If no rotation has
been applied this represents a 3 x 3 identity matrix.

The next line indicates that the material file format is used.  This is the standard format
for XFDTD geometry files.  In this format only cell locations which contain at least one
edge with material other than free space are listed in the geometry file.  The next line of
the example file indicates whether dielectric and/or magnetic material meshes are
present.  The 1 0 variables in the example indicate that a dielectric mesh is present (the
1) but that a magnetic material dual mesh is not present (the 0).  Since only a dielectric
mesh is present, only information about this mesh is included in the geometry file.  The
next number indicates that 30 FDTD dielectric mesh locations contain material other
than free space.  The remaining lines of the geometry file contain the meshed geometry
information.  Each line corresponds to a corner of one FDTD cell.  The first three
numbers give the I, J, K index location of that corner, 21, 21, 21 in the example.  A
position in the mesh is described by integer variables I, J, and K, where the coordinates
of the particular mesh corner are then x=I x, y=J y, and z=K z.  The next three
numbers in the line, 0 0 1 in the example geometry file, indicate the material type
number for the x, y, and z edges at that corner.    For this position the z components of
electric field interact with perfect conductor (material type 1) or in other words, this cell
edge will be drawn as PEC material in the geometry.  If the dual magnetic material
mesh had been specified, the file would continue with one line containing a single
number indicating the number of magnetic mesh cells containing magnetic material,
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Geometry file version 3.8

 41 41 72
 1.000000e-002 1.000000e-002 1.000000e-002
 0 0 0
 0
emat02: 
mmat02: 
1.000000e+000 0.000000e+000 1.000000e+000 0.000000e+000 1.000000e+003
1.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0
0.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0
emat03: 
mmat03: 
1.000000e+000 0.000000e+000 1.000000e+000 0.000000e+000 1.000000e+003
1.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0
0.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0
.
(materials 4-26 are skipped here)
.
emat27: 
mmat27: 
1.000000e+000 0.000000e+000 1.000000e+000 0.000000e+000 1.000000e+003
1.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0
0.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 0
0
1.000000e+000 0.000000e+000 0.000000e+000
0.000000e+000 1.000000e+000 0.000000e+000
0.000000e+000 0.000000e+000 1.000000e+000
Array format: material
 1 0
30
21 21 21 0 0 1
21 21 22 0 0 1
21 21 23 0 0 1
21 21 24 0 0 1
21 21 25 0 0 1
21 21 26 0 0 1
21 21 27 0 0 1
21 21 28 0 0 1
21 21 29 0 0 1
21 21 30 0 0 1
21 21 31 0 0 1
21 21 32 0 0 1
21 21 33 0 0 1
21 21 34 0 0 1
21 21 35 0 0 1
21 21 37 0 0 1
21 21 38 0 0 1
21 21 39 0 0 1
21 21 40 0 0 1
21 21 41 0 0 1
21 21 42 0 0 1
21 21 43 0 0 1
21 21 44 0 0 1
21 21 45 0 0 1
21 21 46 0 0 1
21 21 47 0 0 1
21 21 48 0 0 1
21 21 49 0 0 1
21 21 50 0 0 1
21 21 51 0 0 1

Table 1  Example .id file which can be generated and read by XFDTD.

followed by that number of lines containing the I,J,K indices for the magnetic mesh cells
containing material and the material numbers for each of the three magnetic field
components, organized as for the dielectric mesh. 
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12 Subgrids

A very powerful feature of XFDTD is the ability to specify one or two subgrids with
smaller cells than the main grid.  Proper use of this feature requires following several
rules.  Improperly constructed subgrids can lead to instabilities, especially when many
timesteps are computed.

The subgrid implementation in XFDTD is extremely general.  One important feature is
that perfect conductor and lossy dielectric materials can cross the subgrid-main grid
boundaries.  This allows a subgrid of finer resolution within a dielectric body.  However,
due to the interpolation of electromagnetic fields between main and subgrids, there
must be continuity of the materials in the normal direction to the boundary.  Any non-
free space materials must either continue through the boundary or be spaced at least 4
cells away from the boundary for a 1/3 cell grid and 6 cells away from the boundary for
a 1/5 cell grid.  This spacing may need to be increased if stability problems occur or if
the cell size is very small compared to the wavelength.  This applies whether or not the
material is passing through the main grid/subgrid boundary.  Although sources may be
located within a subgrid, the source must be located away from the boundary of the
subgrid with the main grid by at least 4 cells (for 1/3 ratio) or 6 cells (for 1/5 ratio). 
Subgrid regions may not overlap, and must be separated by at least 3 main grid cells. 
A subgrid may not be located within 6 cells of the outer boundary.  

The subgrid has the effect of overwriting any geometry in the main grid.  If free space
cells in the subgrid overlap material in the main grid, the main grid materials will be
changed to free space during the calculation.   There is no need to define the geometry
in the main grid in the region of the subgrid, but if there is something there it will not be
part of the calculation.    As an example, if there is a box in the main grid and an
antenna will be added in a subgrid, any part of the box overlapped by the subgrid must
be added to the subgrid geometry.  Otherwise the overlapped box will be considered
free space.

To further illustrate proper and improper subgrid techniques in XFDTD, some example
geometries are shown here.   First, if a dielectric material passes from the main grid
into the subgrid, there must not be discontinuities in the normal direction for the first few
cells of the subgrid.  Also, the dielectric in the main grid must be reproduced in the
subgrid.  See Figure 56 for an illustration.   As is mentioned in the caption, the two
dielectrics may be chosen as different XFDTD materials, but the constituitive
parameters must match.  

A material in the subgrid may not end near the main grid-subgrid boundary as shown in
Figure 57.  This is an improperly formed subgrid which will possibly lead to an unstable
calculation.
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Figure 56: An example of dielectric passing from the main grid into a
subgrid.  Note that the subgrid dielectric must have the same material
parameters as the main grid dielectric, but it does not have to be the
same XFDTD material number.  Here the main grid dielectric is material
10 while the subgrid dielectric is material 8.  The two dielectrics must
have the same constituitive parameters though.

Figure 57: An example of an improper main grid-
subgrid geometry.  Here there is a discontinuity near the
interface which can lead to instabilities.
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Figure 58: A PEC wire passing through the main grid-subgrid
interface correctly.

Figure 59: A poorly formed subgrid with a discontinuity near the main
grid-subgrid boundary.

PEC may pass through the main grid-subgrid interface, but it must do so in the normal
direction and continue for several cells on each side.  See Figure 58 for an example of
a wire passing through the boundary properly.  

Once again, there must not be any discontinuities in the normal direction near the main
grid-subgrid boundary.  See Figure 59 for an example of a poorly formed subgrid. 
Here the PEC wire runs parallel to the boundary only two cells away.  There should be
at least four subgrid cells between the boundary and this turn in the wire.  
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Note that the material types are specified independently in the main and subgrids.  That
is, material type 2 may be specified with different permittivity in the main and each
subgrid.  Material type 2 can even be a totally different type of material in each grid. 
For example, material type 2 could be a normal dielectric in the main grid, a Debye
material in subgrid 1, and a Lorentz material in subgrid 2.  When making FDTD
calculations the material inside the subgrid takes precedence over the materials
specified in the same region of space in the main grid.  

When materials cross the main grid/subgrid boundary, the alignment can be checked
by choosing to view All Grids.  This is done by selecting the appropriate window in the
Windows version of XFDTD, or through the View/Set Viewing Space menu in the Unix
version of XFDTD.  If the Grid is displayed, then a slight overlap of the main and
subgrids is evident.  This is due to the interpolation scheme used between the two
grids.  For materials that cross the boundary, the same material type should be set in
the outer subgrid cells and the inner main grid cells that touch the main grid/subgrid
boundary. To help setting the alignment, the mouse cursor position for both grids is
displayed when the view is set to All Grids.  If material is to cross the boundary, the
exact cellular coordinates of the material can be found in both grids.

The subgrid interpolation scheme is designed to allow dielectric materials to have
boundaries which cross the main grid-subgrid boundary.  However, magnetic materials,
if they cross the main grid-subgrid boundary, must be uniform within 5 cells of the
boundary in order to avoid instability and inaccuracy.

The subgrid position within the main grid can be adjusted easily by changing the offset
of the subgrid.  This is done by selecting the Subgrid Location in Main Grid option
from the Edit menu.  The subgrid location is offset by slightly from what appears on the
screen due to some hidden cells in the subgrid.  For example, setting the offset of a 3:1
subgrid to 5 cells will start the subgrid just past cell 6.  This is because there are two (or
3 with 5:1 ratio) extra subgrid cells which are not drawn that are used as boundaries.

Computational Price for Subgrids:  
There is a computational price that must be paid in order to have the higher spatial
resolution.  A part of this price is additional memory requirements.  For a 1/3 cell size
ratio, each main grid cell is replaced by 27 subgrid cells.  For a 1/5 cell size ratio, each
main grid cell is replaced by 125 subgrid cells.  Even a fairly small subgrid region may
quickly need more memory than the entire main grid.  So subgridding should be used
only when absolutely needed.

Another computational burden imposed by subgrids is that, since the subgrid has
smaller cells, the time step in the subgrid is smaller than in the main grid.  Furthermore,
in order to increase stability, even the main grid time step is reduced below its normal
value when subgrids are present.  This is done automatically, but does mean that for
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the same simulation time in seconds more FDTD time steps in the main grid are
required.

While the XFDTD implementation of subgrids is designed to give greater freedom in
application, the possibility of instability remains.  This is due to the interpolation of the
fields between the main and subgrids.  When using subgrids, care should be taken
when specifying the number of timesteps.   The minimum number of time steps that will
allow convergence to steady state or quiescent field values should be chosen.  A 
subgrid must have dimensions that are at least four main grid cells as a minimum.  If
instability is encountered, the symptom is rapidly growing field values that oscillate
rapidly.  If this happens, some possible ways to attempt to remove the instability are by
specifying fewer time steps, by changing to 1/3 size subgrid cells if 1/5 size cells have
been specified, or by enlarging the subgrid size to allow a larger boundary between the
grids.  
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13 CALCFDTD Computer Program

The actual FDTD calculations are not made by the XFDTD graphical user interface. 
Once the geometry and project file are specified using the XFDTD menus, they must be
saved before any calculation can be run.  A separate computer program called
CalcFDTD makes the actual FDTD calculations.  The XFDTD Graphical User Interface
then will operate on and display the results of the FDTD calculations.  

The CalcFDTD computer program reads the project and geometry files written by
XFDTD and performs the actual FDTD calculations.  It is an executable program 
written in the C language.  It includes dynamic memory allocation so that different size
FDTD spaces may be accommodated without allocating more computer memory than
necessary. 

To run the CalcFDTD program, simply start it by selecting Run CalcFDTD from the
Results menu.   The progress of the calculation will be displayed in a window.

Additional options in Unix

In a Unix environment it is often more desirable to run CalcFDTD as a batch job or from
the command line.  To do so, simply enter the following:

calcfdtd50  [options]  filename(.fdtd) 

where "filename" is the name of the Project file (The .fdtd suffix need not included in the
calcfdtd50 command line).

For normal operation no options need be specified.  There are several options
available should they be of interest.

-rev print revision date

-ver print version number

-Z compress the field snapshot files (*.fld files) after creating them in
order to save disk space.  XFDTD will read the compressed files

-gz gzip the field snapshot files (*.fld files) after creating them in order
to save disk space.  For this function to be used the gzip and
gunzip programs must be executable and in the path.
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Figure 60: Creating the example
geometry.

14 Example Procedures

In this section procedures for making an FDTD calculation will be illustrated by some
examples.  Four cases are examined in detail.  These are:  a monopole on a
conducting box, a microstrip meander line, a stripline Wilkinson power divider, and a
dipole near a lossy dielectric sphere.  Several other examples are briefly discussed in a
separate section.  The XFDTD files for the geometry and run parameters for all
examples are included with the XFDTD50 CDROM.  The monopole on conducting box
example is considered first and in some detail.  New users are encouraged to follow
this example before loading the provided files as it explains the basic operation of
XFDTD 5.0.

14-1 Monopole Antenna on a Conducting Box 

This example was considered in [7] on pages 279-289.  Here we will calculate the
impedance vs frequency for a 50 mm long monopole antenna on a 60 x 10 x 50 mm
box. The XFDTD50 input files monbox50.id and monbox50.fdtd furnished with
XFDTD50 correspond to this example.

Following the description in [7] on page 283, we will use 1.67 mm cubical FDTD cells. 
This will give us 30 cells per wavelength at 6 GHz, which should provide very accurate
results.  With this cell size the box will be 35 x 6 x 30 cells and the monopole will be 30
cells long.  With a 15 cell border our FDTD space will be 67 x 37 x 91 cells.  For the
calculations in [7] a space of 130 x 90 x 180 cells was used, since the absorbing outer
boundary used for those calculations required a much larger border in order to provide
adequate absorption of the radiated fields.  The savings for XFDTD are considerable. 
The calculation in [7] required over 2 million cells, while the calculation here needs just
over 10% of that number.  

1)  After starting XFDTD by entering "xfdtd50" or launching from the Programs bar, click
on File then on New, or select the New Geometry icon from the Tool bar.  

2)  Choose to create a Main Grid.  This will bring up
the menu shown in Figure 60. For our example we
set the spatial increments as 1.67 millimeters, the
space dimensions as 67 x 37 x 91, and specify only
an electric grid.  Our example geometry has no
magnetic materials, so the magnetic grid is not
needed, nor will we need to create a Subgrid.

3)  The next step is to put our geometry into the
FDTD main grid.  Open the Geometry Editing Tools
by selecting them from the Edit menu or by pressing the icon on the Tool bar.  From the
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Figure 61: The rectangular box primitive menu with the
data entered for the monbox base.

Figure 62: The Wire primitive
data for the monopole.

Materials Palette, select material PEC.   Then select New on the Geometry Editing
Tools window and then select Rectangular Box from the library menu.  To locate the
box with monopole in the center of the space we determine the mesh locations for the
surfaces.  The constant x surfaces are at x=16 and x=51 (cells), the y surfaces at y=16
and y=22, and the z surfaces at z=16 and z=46.  Using the Rectangular Box primitive,
construct the box by defining the three points as (16,16,31), (16,22,31), and (51,16,31). 
Set the thickness to 30 cells.  The windows should appear as shown in Figure 61.

4) Press OK on the Rectangular Box menu to add the primitive to the list. Then  press
the Mesh All button to add the box to the geometry.  

5) The next step is to add the monopole antenna.  We
want this monopole antenna to be fed with an Ez field
at location (33,19,46) in the center of the box.  So this
cell edge is left as free space to accommodate the
feed.  The monopole itself is "built" by setting Ez cell
edges from (33,19,47) to (33,19,76) as perfect
conductor.   Add this wire with the Wire primitive in
the object library by selecting New and then Wire on
the Geometry Editing Tools window.  Enter the two
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Figure 63: The Waveform menu after setting the pulse width and
number of timesteps for the monopole on a box example.

points as shown in Figure 62.  Press OK and then Mesh All to add the wire.

Note: The box and the wire monopole can also be defined using the mouse-driven
tools (User-Object).   The primitives are used here for simplicity.

6)  When we are finished we can close the Edit Geometry Tools, then slice through the
space to check the geometry.  The geometry may also be displayed in three
dimensions by selecting the 3D view.

7)   If the geometry looks correct, save the file by selecting File and then Save from the
menu bar.  

8) The next step is to define the parameters for the XFDTD calculation.  Start by
selecting File, then New, then Project. 

Note: This step is not required with the Unix version of XFDTD as the Project file is
created with the Geometry file. 

9)  Now open the Edit menu (be sure the Run Parameters window is active in Windows) 
and select Stimulus.   We are interested in feeding the antenna with a voltage source,
so select the Sources/Loads sub-menu.    To set the input waveform, press the
Waveform button.  We want to set the excitation as Gaussian with a pulse width of 32
time steps and run the calculation for 1200 timesteps.  See Figure 63.  Press OK to
close the window.
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Figure 64: The sources/loads menu after entering the appropriate data
for the monopole on a box example.

10)  The Feed is located at x=33, y=19, and z=46 in the main grid and is z-directed. 
Specify a series source resistance of 50 ohms to reduce the number of time steps
needed for the transients to dissipate.  Select Add feed to list and, if desired, set the
active port for an S-parameter calculation.  The resulting window should appear as
shown in Figure 64.

11)  After closing the Stimulus Sources/Loads menu, click on Planar Transient Fields
in the Edit menu.  Here choose to save fields in the xz plane at y=19 every 20 time
steps from time step 20 to time step 320.   This will give 18 snapshots for later display. 
Select Add Sequence and press OK.  See Figure 65 for an example of this menu.

12) To view the input impedance FFT size, open the Edit menu and look for Compute
Input Impedance.   The FFT size should default to 2048.  Select Compute Input
Impedance to open this window.  Then change the FFT size to 4096.   Pressing on this
option toggles the input impedance, so if it is already selected (with a check mark), you
will need to select this item twice to make the FFT menu appear.

12) Choose File then Save from the main menu and enter a name for the Project file. 
The project is now ready to run.
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Figure 65: The Transient fields
window after entering the
appropriate data.

13) The calculation is started by selecting Results and then Run CalcFDTD.  On the
Windows version, a window will appear asking for the priority, select Normal.  In Unix
simply select Run CalcFDTD.  The calculation will then begin and a status window will
open to display the progress of the calculation.  This calculation required just over 3
minutes on a 400 MHz Pentium II.

Note: On a Unix computer the calculation can be run as either a batch job or from the
command line.  The command for executing the calculation is:

calcfdtd50 monbox50

where calcfdtd50 is the calculation program and monbox50 is the name of the project
file.  Insert the correct file name in place of monbox50.  

14)  Once the calculations are finished, the data is ready for display.  

Note: In the Unix version of XFDTD, the project file must be reloaded first.  Do this by
selecting File then Open Project File.  

15) From the Project Tree, click on the project name, then on output files, then on
Transient Field Sequence as shown in Figure 66.  Select the sequence.
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Figure 66: The project tree after the calculation.

Figure 67: The field display of the monopole on a box geometry.

15) Open the Field Controls tool (if it is not already opened) either through the
Results/View Fields menu or from the icon on the Tool bar.  Choose to display Ez with
a dB scale with dB increment of 15.  Then start the sequence by pressing the Play
button.  The field snapshots of the fields will be sequentially displayed.  A view of the
fields after 80 time steps is shown in Figure 67. 
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Figure 68: The Plotting tool after selecting the Real
and Imaginary parts of the monopole impedance.

16)  Next consider the input impedance for the monopole.  From the Results menu click
on Display Plot.   Choose to view Data versus Frequency and then in the Available
Plots window find Input Impedance vs Frequency entry.  Select this entry and choose
Real and press Add to Plot.  Press Imaginary and again press Add to Plot.  The Plot
window should look like Figure 68.

If using the Windows version, press Next and then set xmin to 0.2, xmax to 6.0, ymin to
-1000, and ymax to 1000.   In the Unix version, this is done by pressing the Edit Plot
Parameters button. After specify titles the resulting plot as it would appear on the
computer screen is shown in Figure 69.  It compares very well with measured results
shown in Figure 14-27 of [7].
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Figure 69: The input impedance plot of the monopole.

14-2 Microstrip Meander Line 

The next example is of S-parameter results for a microstrip meander line.  The
meander50.id and meander50.fdtd files that correspond to this example are included
with XFDTD.  This example can be loaded and the results viewed in XFDTD.  

The meshed meander line geometry is in the x-y plane at z=3.  This can be viewed
using XFDTD50 and going to the z=3 plane.  The geometry and measured results are
taken from [18].  The meander line is on a dielectric substrate 0.49 mm thick with
dielectric constant 2.43.  The FDTD cell size is 0.245 mm cubes so that two cells
correspond to the thickness of the substrate.  The electric field mesh locations on the
surface of the substrate are assigned a dielectric constant of (2.43 + 1)/ 2 = 1.72 to
correctly model the air/dielectric interface in the FDTD equations.  The stripline width is
1.41 mm which was meshed using 6 FDTD cells.  The lengths of the “meanders” are
9.87 mm or 40 cells and the spacing between “meanders” is 0.94 mm or 4 cells.  The
distance from end to end of the line is 60 mm or 245 cells.  The Liao absorbing
boundary is chosen.  With ample spacing to the absorbing outer boundary a calculation
space of 286 x 122 x 25 cells results.   Using the Courant limit time step size, the FDTD
calculation required approximately 6,000 time steps to converge.  The calculation took
about 2 hours on a Pentium Pro 200 MHZ processor PC using the SCO ODT 5
operating system and optimizing C language compiler.  
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Figure 71  XFDTD calculation of S21 for meander line
compared with measurements.

Figure 70: Detail of the Meander Line feed.

Details of the port feed geometry FDTD
mesh at one end of the meander line
can be seen in XFDTD50 in  the y-z
plane at x=21 (see Figure 70). Use the
translate and zoom function to see the
feed region in detail.  The green
rectangle indicates the FDTD mesh
edge where the feed port is located. The
simple transition from the feed port
location to the wider stripline conductor
has been observed to provide more
accurate results, especially at higher
frequencies.  The lowest plane of mesh edges is set to perfect conductor to simulate
the ground plane.  This mesh geometry is an approximation to a coaxial feed or
termination connected to the bottom of the ground plane with the center conductor
flaring and connecting to the microstrip.  For the FDTD meander line calculation both
R01 and R02 are set at 50 Ohms, corresponding to a coaxial cables with 50 Ohm
characteristic resistance.  This can be seen in the Stimulus Sources/Loads sub-menu. 
The Gaussian pulse width has been set to 50 time steps.  This will converge faster than
a pulse width of 32 time steps, and with the dielectric present accurate results at the
higher frequencies that would be excited by the narrower pulse will not be accurate.

As this geometry is already meshed and the project file is defined, the calculation can
be run using Results/Run CalcFDTD.   When the run is complete, the results can be
displayed using the Display Plot submenu.
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The result S21  is plotted in Figure 71 and compared with measurements from [18].  The
agreement is quite good, comparable or better than the calculated results given in [18]
and much better than the Touchstone results also shown in [18].  

14-3 Stripline Wilkinson Power Divider

This example is for a stripline Wilkinson power divider. The wilk50.id and wilk50.fdtd
files that correspond to this example are included with XFDTD50.  You are encouraged
to load these files into XFDTD50 and follow along with the following discussion. 

The layout of the power divider will be shown in XFDTD50 in the x-y plane at z=7.  Port
1 is at the bottom, Port 2 at the upper left, and Port 3 at the upper right.  The FDTD cell
size is .112 x .112 x .127 mm, with the total FDTD space being 155 x 199 x 12 cells. 
The overall dimensions of the stripline conductors are 19.94 mm or 178 cells from Port
2 to Port 3, and the overall distance from Port 1 to the far edge of conductor is 15.57
mm or 139 cells.  The dielectric has permittivity 2.94 and the total dielectric thickness is
1.524 mm, with the stripline conductor sandwiched in the middle.  The blue square is a
100 Ohm isolation resistor fabricated using 100 Ohm/square resistive material.    

Care must be taken in meshing the power divider.  First the stripline planes of the
FDTD space are set to conductor, while the 4 sides are terminated in Liao absorbing
boundaries.  The entire FDTD space is filled with dielectric except for the stripline
conductor and the isolation resistor.  The stripline conductor is meshed as one plane
thick perfect conductor.  The isolation resistor is meshed using one plane thick lossy
dielectric with permittivity of free space and conductivity of 78.74 Ohms.  This is
obtained using a simple sheet impedance model [1] as the reciprocal of the product of
the sheet resistance and the cell thickness.  The cell thickness is set at 0.127 mm in
this dimension so that 12 cells correspond exactly to the dielectric thickness.  The other
two cell dimensions in the plane of the conductor were chosen to allow precise
alignment of the mesh edges with the conductor steps.  

A very important consideration is location of the mesh edges where the port sources
and terminations are to be located.  One approach might be to terminate the side
boundaries of the FDTD mesh normal to the stripline conductor with perfect conductor
planes.  Then a mesh edge normal to the outer conductor plane could be used as the
source location, with the stripline conductor touching it and starting one cell inside the
mesh.  This would correspond physically to a stripline constructed inside a metal box
with all sides closed and fed by coaxial cables with the outer conductor attached to the
metal box and the center conductor going through the metal box surface to feed the
stripline.  

This feed geometry, while a reasonable approximation to a realistic stripline circuit,
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does not yield good FDTD results in some situations.  The difficulty is that, with the
FDTD calculation entirely enclosed by conductor, the only means of dissipating the
energy supplied to the calculation is by dissipation in the characteristic resistors, and of
course in any other lossy dielectric materials.  But many devices are made entirely or
almost entirely from lossless dielectric and conductor, and some of the induced energy
may be at frequencies such that it is not absorbed by the characteristic resistors.  This
energy then “rattles” around inside the conducting walls of the FDTD space, greatly
increasing the number of time steps needed for convergence.  It is therefore desirable
to have the four side walls of the FDTD stripline calculation mesh be absorbing rather
than conducting.

Given this consideration, a feed location that drives the stripline with voltages relative
to the top or bottom conductor is desired, so that the sides of the FDTD mesh may then
be set as absorbing boundaries. However, feeding from just the top or just the bottom
conductor does not provide the symmetry necessary to excite the dominant field modes
of the stripline.  A symmetrical arrangement for exciting and terminating the stripline
can be seen in the XFDTD50 display of the geometry by viewing the y-z plane in the
x=12 slice. Using zoom and translate get a clear view of the mesh surrounding edge
(12,189,7), the location of one of the ports.  The medium intensity white horizontal line
is the center of a stripline conductor.  This conductor is several meshes wide
perpendicular to the plane of this slice of the FDTD mesh.  The vertical white line is a
line of FDTD mesh set as conductor which connects the port to both the upper and
lower conducting surfaces.  This arrangement allows the port voltage and current to be
symmetrical with respect to both stripline conducting surfaces, and is used for all three
ports of the stripline circuit.

The procedure used for the meander line example is followed again, with the extension
to a three-port circuit.  The characteristic resistances at each port are set to 50 Ohms. 
Port 1 is fed so that S parameters S11, S21 and S31 will be determined.  The Gaussian
pulse is made very wide, 1024 time steps, to reduce the number of time steps needed
to reach convergence.  Results are higher frequencies that would be excited by a
narrower pulse are not of interest.

Figure 72 shows the S11 calculation made by XFDTD50 for the Wilkinson power
divider.  The Compute s-parameter plot data menu was used to increase the size of the
FFT used for the S-parameter calculation so that the plot over this frequency range
would be smooth.
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Figure 72  Magnitude of S11 for stripline Wilkinson power
divider calculated using XFDTD.

14-4 Dipole Near Lossy Sphere
 
This example is based on the COST 244 canonical model of a layered lossy sphere. 
The sphere is intended to be a rough approximation to a human head.  The sphere has
an outer diameter of 20 cm which includes a 0.5 cm thick outer layer representing the
skull bone.  Calculation frequencies for the model are 900 and 1800 MHz.  The
example here uses FDTD cells small enough for 1800 MHz calculations, but only 900
MHz results are considered. For the SAR calculations the material parameters at 900
MHz are relative permittivity 17, conductivity 0.25 S/m, and density 1200 kg/m3 for the
outer skull layer.  For the inner brain volume the parameters are relative permittivity 43,
conductivity 0.83 S/m, and density 1050 kg/m3. 

The sphere is excited by a 0.4 wavelength long dipole with a 0.25 cm feed gap and a
wire diameter of 0.25 cm.  The dipole is located 1.5 cm from the outer surface of the
sphere.  At 900 MHz the wavelength in free space is 33.33 cm so the  dipole then has a
total length of 13.33 cm.

Desired output results are the SAR distribution relative to a maximum value, the total
absorbed power with reference to the total radiated power, the input impedance of the
dipole, and the radiation pattern.  These quantities are all easily obtained using
XFDTD.

We first determine the cell size and spatial volume.  With the relative permittivity of the
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brain tissue of 43, the shortest wavelength in the problem space is inside the brain, and
is the 1800 MHz free space wavelength divided by the square root of 43, or
approximately 0.25 cm.  This is also a convenient cell size for modeling the dipole gap
and wire diameter, since the wire diameter is approximately the cell size.  We could use
the XFDTD capability to include thin wires, but for this cell size and wire diameter it is
not needed.  This cell size will provide 20 cells per wavelength at 900 MHz.  This is
more than needed, but lets us use the same mesh for both frequencies.

With 0.25 cm FDTD cells, the sphere diameter is 80 cells and the dipole is 6 cells away
from the sphere surface.  With a 20 cell free space border on all sides, this results in a
130 x 120 x 120 cell space where we have allowed a few extra cells to separate the
dipole from the outer boundary.  

To set up the calculation start XFDTD and create a space 130 x 120 x 120 cells with
0.25 cm cells.  From the Geometry Editing Tools window, choose the sphere.  One way
to mesh the two layers is to first mesh a 40 cell radius sphere centered at 60, 60, 60
with material type 3.  Then mesh a 38 cell sphere centered at the same location with
material type 2.  The two cell layers corresponds to the 0.5 cm skull outer layer. 
Meshing the larger sphere first assures that there will be no air gaps where the layers
join.

Next mesh the dipole.  This could be done manually with the mouse, but can also be
done with the wire function from the library.  The dipole is 53 cells long, so each dipole
arm is 26 cells and there is a 1 cell gap at the center.  We choose to put the dipole in
the xz plane at y=60.  The x location of the wire is 46 cells from the center of the
sphere, or x=106.  The center of the dipole will be cell edge 106, 60, 60.  To use the
wire library function for the upper half of the dipole wire, set end 1 to 106, 60, 61 and
end 2 to 106, 60, 87 with material PEC then click on add object.  If the XFDTD slice is
set to xz plane at y=60 the upper half of the dipole should appear.  To mesh the lower
half, set end 1 in the wire function to 106, 60, 60 and end 2 to 106, 60, 34.  The result
should be the wire dipole with each arm 26 cells and a 1 cell gap in the middle.  

Be sure to set the relative permittivity and conductivity of materials 2 and 3 to the
parameters given above for brain and skull.  Also set the densities for materials 2 and 3
to the brain and skull parameters given above.

Next set the excitation of the calculation.  From the Stimulus-Sources/Loads menu add
a +Z voltage source at location 106, 60, 60 with a zero resistance source resistor. Then
set the frequency to 900 MHz (0.9 GHz) with 2500 time steps.   Choose the steady
state far zone transformation so far zone patterns can be calculated.

Finally save the necessary results.  Using the Save Near Zone Data menu save the Ez
and Jz electric field and current density at the feed location, 106, 60, 60.  In order to
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calculate the maximum SAR, from the FDTD-Save All Steady State Quantities-SAR
Planes menu save all SAR xz planes.

Then save the geometry and XFDTD project files using the appropriate menus from
File.   Then run the calculation.  This calculation took approximately 55 minutes on a
400 MHz Pentium II computer.

Once the calculations are finished reload the project file to perform some
postprocessing.   From the Results-Steady State Data display you should see the feed
point 1 impedance of 27.90-j111.82 ohms.  The antenna efficiency is 29%.  This means
that 71% of the power supplied to the antenna is absorbed in the lossy sphere.  

In order to obtain SAR information, use the Results-Compute SAR Statistics menu and
select the x-z plane since these were the planes saved.  Once the SAR calculation is
complete, you can then use the Results-Display SAR Information menu to see the
resulting SAR information.  The input power can be scaled on this menu.  With the
scale input power set  to 1 Watt on this menu, the Maximum SAR is approximately 11.4
W/kg.  

The SAR distribution can be seen in false color using XFDTD. To do this load a SAR
file using the Project Tree.  The distribution for the unaveraged SAR in the y=60 plane
is shown in Figure 73.  To allow the colors to be displayed more clearly the material
display is toggled off.  The dipole is actually in this plane, and will be visible when the
file is first loaded.  The color display may also be changed by changing the dB
increment from the 18 dB used for this figure.

The far zone radiation pattern can be obtained from the Results-Compute Far Zone
Plot Data.  Choose a constant theta pattern with theta = 90 degrees, and let phi cover
from 0 to 360 degrees in 2 degree increments.  The pattern calculation will require
some time.  Once it is complete the result can be displayed using the Results-Display
Plot menu.  The result for E-theta polarization is shown in Figure 74.
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Figure 73 Unaveraged SAR distribution for Dipole near
Lossy Sphere example in the y=60 plane with the input
power scaled to 1 Watt.

Figure 74 Azimuthal radiation pattern for Dipole near Lossy Sphere
example.
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14-5 CDROM Example Files

There are four groups of files on the XFDTD5.0 CDROM which include example results
for viewing.  The various examples are discussed briefly here.  Refer to the actual
example files for the results.

14-5-1 Antenna Examples

Cellular Telephone Example

These files contain an example of a detailed cellular telephone handset.  The
dimensions and internal distribution of the telephone are designed to be similar to an
actual telephone, but the internal components are not functional.  The telephone has a
helical antenna which is simulated in XFDTD with a subgrid.  To view both the
phone and the helix, choose the "All grids" option for viewing.

The phone is fed with a 1.9 GHz sine wave. Several time-domain near-zone electric
fields and current densities can be viewed with the plotting tools.  There are also two
field sequences for watching movies of the field propagation.  The steady-state input
impedance, input and radiated power, efficiency and S parameters can be seen
by selecting "Steady-State Data" from the Results menu. 

Antenna patterns in any plane can be computed by selecting the Compute Far-Zone
from the Results menu.  Enter the desired pattern, add it to the list, and then press OK. 
The pattern can be viewed with the plotting tool by choosing Plots vs Angle.

Simple Subgrid Example - Helix on a Box

These files demonstrate the use of a subgrid by showing a simple  PEC box in the main
grid and a helical antenna in the subgrid.  Two cases are computed:  a steady-state
calculation with a sine wave input, and a transient calculation with a broad-band
gaussian pulse input.

The steady-state example, helix.fdtd, displays field sequences in the main grid and in
the subgrid.  The steady-state port information is available from the
Results->Steady-State data menu.  Antenna patterns in any plane may be computed by
selecting Results->Compute Far-Zone Data.  The antenna patterns may be view with
the plotting tools by selecting the plot versus angle option.  Also available are the
near-zone field values at the feed versus time.

The broad-band example, helgaus.fdtd, also contains field sequences in both grids. 
The input impedance and S11 versus frequency may be plotted.  Time domain data
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Figure 75: XFDTD 5.0 calculations of S11 compared with
measurements.

available includes the feed voltage and current.

Coplanar Waveguide Slot

Measured and calculated results for a Coplanar Waveguide Slot antenna are given in
the paper "FDTD Analysis of CPW-Fed Folded-Slot and Multiple-Slot Antennas on Thin
Substrates" by Tsai and York, IEEE APS Transactions, February 1996.   XFDTD has
been applied to a folded slot antenna as shown in Figure 1 of the paper.  Using the
Magnetic Wall capability of XFDTD, only half of the slot geometry needs to be included
in the calculation.  Figure 75 shows a comparison between results obtained using
XFDTD and measurements from the paper. Many more results can be seen by loading
the XFDTD project file cpwfslot.fdtd into XFDTD.

Patch Antenna

XFDTD Version 5.0 is used to calculate the S11 scattering parameter for a microstrip
patch antenna. The geometry and measured results for S11 are given in the paper 
"Applications of the Three-Dimensional Finite-Difference Time-Domain Method to the
Analysis of Planar Microstrip Circuits" by Sheen et al in the July 1990 issue of IEEE
Transactions on Microwave Theory and Techniques, pp 849-856.  

The XFDTD 5.0 calculations are on an FDTD mesh with the same size cells as in the
Sheen paper, but in a space only 60x75x16 FDTD cells due to improved methods of
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Figure 76: Geometry of microstrip patch antenna as meshed in
XFDTD 5.0.

feeding the antenna and in performance of the absorbing outer boundary. The XFDTD
5.0 calculation also requires only 4,000 time steps rather than the 8,000 time steps
needed by Sheen, again due to improvements in the feed method incorporated into
XFDTD 5.0  Finally, the agreement with measurements is better than shown in the
Sheen paper.  The XFDTD 5.0 calculation required approximately 4 minutes on a
Pentium 400 MHz Computer using Windows NT Operating System.  See sample output
in Figure 76, Figure 77, Figure 78, and Figure 79.
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Figure 77: Ez (out of plane) electric field after 160 time
steps due to Gaussian Pulse excitation

Figure 78: Jy (vertical) current density after
160 time steps due to Gaussian pulse
excitation
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Figure 79: Comparison of S11 computed by XFDTD 5.0 and
measurements.

14-5-2 Microwave Examples

The Lange coupler and Wilkinson Power Divider results (in the directories
examples/lange and examples/wilkinson on the CDROM) are both taken from the PhD
dissertation of Dr. Jose G. Colom.  With his permission a portion of his dissertation is
included on the CDROM as an Adobe Acrobat file colompart.pdf.  The complete
dissertation may be obtained from Remcom Inc by request.  All of the calculations in
the dissertation were made using XFDTD.

4-Finger Lange Coupler

These files show XFDTD results for a 3-dB Lange coupler.  After loading the
lange29.fdtd file, the output available for display includes the time domain voltage and
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current at each port for the case where port 1 is fed.  The S-parameters S11, S21, S31,
and S41 may be viewed through the plotting menu as plots versus frequency.  Also
available is the port power versus frequency. 

Wilkinson Power Divider

These files show XFDTD results for a Wilkinson Power Dividor.  After loading the
wilk.fdtd file, the output available for display includes the time domain voltage and
current at each port for the case where port 1 is fed.  The S-parameters S11, S21, and
S31 may be viewed through the plotting menu as plots versus frequency.  Also
available is the port power versus frequency.  Loading the time-domain field sequence
file, wilk.xy9.i100.b100.e1000.fss will show a movie of the field propagation through the
power divider.

Coplanar Stripline Bandstop Filter

Measurements and calculations for several Coplanar Stripline geometries appeared in
the paper "Coplanar Stripline Component for High-Frequency Applications" by
Goverdhanam, Simons, and Katehi, IEEE MTT Transactions, October 1997.  

Here we have applied XFDTD to the Bandstop Filter of Figure 13 of the paper.  Using
XFDTD 5.0 we have obtained excellent agreement with the measured results shown in
Figure 14 of the paper.   In this set of example files we have included comparison plots
of the measured results and XFDTD 5.0 calculations.  They are shown in Figure 80. 
Display the XFDTD results by loading the XFDTD project file cps13.fdtd into XFDTD.  
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Figure 80: S11 of Co-planar Stripline Bandstop filter compared with
measurements.

14-5-3 Biological Examples

Simple Dielectric Sphere

This example shows a simple dielectric sphere with a radius of 7.33 mm, a relative
permittivity of 72.2, a conductivity of 1.808 Siemens/meter, and a material density of
1000 kg/m3.   The sphere is exposed to an 837 MHz incident plane wave with an
amplitude of 2500 V/m.   The Specific Absorption Rate (SAR) values in the sphere are
saved in one direction (the xy plane) and the 1 and 10 gram averaged SAR values are
computed.  The Results->Display Averaged SAR Information option may be used to
display the maximum and whole body average SAR values and the  the 1 and 10 Gram
Averaged SAR maximums.  Movie sequences of the SAR files may be viewed by
selecting the SAR Sequences entry from the Project Tree. 

Spherical Bowl and dipole example

In this example, a liquid-filled spherical bowl exposed to radiation from a dipole antenna
is simulated.  The bowl is filled with a brain simulating liquid and the 835 MHz
half-wave dipole radiates at a distance of 5 cm from the bottom of the sphere. The
specific absorption rate (SAR) values in all planes of the liquid are saved for viewing. 
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Movies of the SAR through the liquid may be created. The SAR data is available for
averaging using the Results->Compute SAR statistics menu.  The maximum,
whole-body average and maximum 1 and 10 Gram averaged SAR values are available
(after computing the SAR statistics) from the Results->Display SAR Information menu.
Additionally, some data regarding the dipole is available including the steady-state
input impedance, input power and efficiency, and the S11 values at the input frequency. 
Antenna patterns of the dipole/sphere geometry may be computed, if desired.

Comparisons of XFDTD impedance and SAR simulations of this geometry with
experimental data is available in the report "Measurements and FDTD Computations of
the IEEE SCC 34 Spherical Bowl and Dipole Antenna" by Martin Siegbahn and Christer
Tornevik of Ericsson Radio Systems.  This report is included with the CDROM as an
Adobe Acrobat file called ericsson.pdf
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15 Trouble Shooting

The XFDTD programs have been extensively tested and should operate reliably on all
supported platforms.  Should you encounter any difficulties you may contact Remcom,
Inc by phone, fax or electronic mail. 

REMCOM, Inc.
Calder Square
PO Box 10023
State College, PA  16805
Phone: 814-353-2986
Fax:  814-353-1420
E-mail: xfdtd@remcom.com
URL: http://www.remcom.com
 
Before contacting us, however, please consider the following difficulties that may arise
and the suggested remedies.

15-1 Problems with XFDTD 5.0 on Windows

* Colors on screen are incorrect on Windows 98 

There are some problems with Video acceleration for some cards with Windows 98.  To
disable the acceleration, from the desktop click on Properties->Settings->Advanced-
>Performance and set Hardware Acceleration to “none”.

15-2 Problems with XFDTD 5.0 on Unix

* xfdtd50 and/or calcfdtd50 will not execute

Possibly the files are not set as executable.  Use Unix chmod command.

* xfdtd50 gives a message about missing libraries (On Sun Solaris)

On some computers running the Sun Solaris operating system the path to the Motif
libraries must be in the LD_LIBRARY_PATH declaration. 
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For the C-Shell: edit the .cshrc file in your home directory, search for the
LD_LIBRARY_PATH variable.  Add /usr/dt/lib to this line.

EXAMPLE:
setenv LD_LIBRARY_PATH $OPENWINHOME/lib:/usr/new/X11R5/lib:/usr/lib:/usr/dt/lib

For the K-Shell: edit the .profile file in your home directory, search
for the LD_LIBRARY_PATH variable.  Add the /usr/dt/lib to this line.

EXAMPLE:
LD_LIBRARY_PATH=/usr/openwin/lib:/usr/ucblib:/usr/4lib:/usr/lib:/usr/dt/lib

* xfdtd50 and/or calcfdtd50 write license problem message to screen and stop

For Unix installation, check that license procedure was followed and that
xfdtd5.0.license and calcfdtd5.0.license files exist in /etc directory and contain only the
license number supplied by Remcom, NOT your computer serial number.  Contact
Remcom, Inc for correct license number if necessary.  This applies only to the Remcom
supplied licensing.  If a special licensing situation, such as FlexLM is being used, this
message does not apply.

* XFDTD colors appear strange or some materials are not visible in the mesh

Other Unix applications may be using colors that are needed by XFDTD.  Close all
other applications running on the computer platform and start XFDTD again.  After you
start XFDTD look at the window from which you gave the "xfdtd50" command.  If there
is a Unix warning that not all colors could be allocated, then you still have an
application running that is using some of the colors required by XFDTD.

* difficulty reading files with XFDTD

Unix allows a limited number of files in the same directory.  Try to separate files from
different XFDTD calculations into different directories.

* Can’t read files into XFDTD after Upgrade to Newer Version

XFDTD should be fully backward compatible.  This means files created by older
versions of XFDTD should be functional with XFDTD 5.0.   Files created by XFDTD 5.0
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can not be read in older versions of XFDTD (2 - 4) since the formats are different.   It is
recommended that when you receive your new version of XFDTD that you remove all
the XFDTD executable files from the previous version from your computer.
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16  The Human Head and Shoulders FDTD Mesh

You may have received one of our FDTD meshes of a male human head and
shoulders.  This was created using digitized data in the form of transverse color
images.  The data is from the Visible Human Project sponsored by the National Library
of Medicine (NLM) and is available via the Internet at no cost. For information browse

 http://www.nlm.nih.gov/research/visible/visible_human.html

The male data set consists of MRI, CT and anatomical images.  Axial MRI images of
the head and neck and longitudinal sections of the rest of the body are available at 4
mm intervals.  The MRI images have 256 pixel by 256 pixel resolution.  Each pixel has
12 bits of gray tone resolution.  The CT data consists of axial CT scans of the entire
body taken at 1 mm intervals at a resolution of 512 pixels by 512 pixels where each
pixel is made up of 12 bits of gray tone.  The axial anatomical images are 2048 pixels
by 1216 pixels where each pixel is defined by 24 bits of color, about 7.5 megabytes. 
The anatomical cross sections are also at 1 mm intervals and coincide with the CT axial
images.  There are 1871 cross sections for each mode, CT and anatomy.  The
complete male data set is 15 gigabytes in size.  Our mesh of the human head and
shoulders used the axial anatomical images since these had the finest resolution. 

16-1 The 3mm Head and Shoulders Mesh

The choice of the problem space dimensions came from consideration of the computer
resources that would be required to make the calculation.   An FDTD mesh of two
million cells will require about 96 MBytes of RAM.  A cell size of 3 mm was chosen for
the original mesh since it will allow the head and shoulders region, including a 20 cell
border, to be modeled in a space of 153 x 118 x 120 or 2,166,480 cells. 

Creating the XFDTD .id file from the axial anatomical images 

Each of the axial anatomical images contains .33 mm x .33 mm pixels.  We sample
each image every 9 x 9 pixels such that we represent an area 3 mm x 3 mm with one
pixel or 24-bit value.  We convert this 24-bit data value to a corresponding set of
constitutive parameters by assigning tissues to five different tissue types.  Each of
these is also assigned a material type number in XFDTD.  In addition we add a group
for skin.  It was not possible to separate skin from the other tissues from the files, so a
one-to-two cell layer of skin was added manually.  

This grouping or conversion process was done by inspection.  Each 24-bit value that
corresponds to an FDTD cell was originally examined with the help of  [19,20] and
properly placed into one of the above six groups.  
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Dr. Michael Smith and Mr. Chris Collins of The Milton S. Hershey Medical Center,
Hershey, Pa, reviewed the original FDTD mesh developed by Remcom, Inc., and
revised it.  These revisions included improved fidelity, additional shoulder region,  and
removal of small regions of blood which do not correspond to a living human, but
pooled after the death of the human subject.  Information about their research efforts
can be obtained by browsing

 http://nmr.hmc.psu.edu

The six groups of tissue types in the original mesh and their XFDTD material numbers
are: 

XFDTD #2 cartilage
XFDTD #4 muscle 
XFDTD #7 eye
XFDTD #9 brain
XFDTD #12 dry skin
XFDTD #14 skull bone 

These correspond roughly to the tissue groups of the entire body mesh, except that the
entire body mesh: 1) has lung tissue and internal organs which are absent from the
head/shoulders mesh; 2)  combines cartilage with fat and bone; and 3) includes blood.

For each tissue group we have found reasonable approximations to the material density
in kg/m3.  In particular, the values given by Camelia Gabriel, Ph.D., and Sami Gabriel,
M. Sc., Physics Department, Kings College London, London WC2R2LS, UK for
average brain (1030), average skull (1850), and average muscle (1040) are used. 
Their values of conductivity in S/m and relative permittivity are also recommended for
the head/shoulders.  The electrical constitutive parameters change with frequency, and
can be obtained from the www site:

http://www.brooks.af.mil/AL/OE/OER/Title/Title.html

which is supported by

Armstrong Laboratory (AFMC)
Occupational and Environmental Health Directorate
Radiofrequency Radiation Division
2503 D Drive
Brooks AFB
TX  78235-5102

Approximate values for different frequencies as given by Camelia Gabriel, Ph.D., and
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Sami Gabriel, M. Sc. and  obtained from the indicated www pages are given in the table
below for convenience:

Material  150 MHZ 300 MHZ 500 MHZ 700 MHZ

#2
cartilage

0.498
51.4

0.552
46.77

0.621
44.60

0.697
43.46

#4
 muscle

0.749
62.68

0.791
58.98

0.844
57.32

0.902
56.50

#7
eye

0.926
63.47

0.975
58.90

1.033
56.89

1.096
55.91

#9
 brain

0.479
60.19

0.553
51.90

0.626
48.42

0.695
46.80

#12
dry skin

0.543
61.50

0.641
49.82

0.728
44.91

0.800
42.70

#14
 skull

0.127
19.98

0.149
18.30

0.177
17.45

0.208
16.97

Material  900 MHZ 1.2 GHz 1.5 GHz 1.9 GHz 2.3 GHz

#2
cartilage

0.782
42.65

0.929
41.72

1.098
40.93

1.354
39.98

1.641
39.10

#4
 muscle

0.969
55.95

1.088
55.36

1.228
54.87

1.448
54.30

1.705
53.77

#7
eye

1.167
55.27

1.290
54.58

1.435
54.04

1.662
53.42

1.925
52.84

#9
 brain

0.766
45.80

0.882
44.82

1.010
44.11

1.204
43.37

1.423
42.75

#12
dry skin

0.867
41.40

0.967
40.21

1.072
39.43

1.224
38.71

1.395
38.18

#14
 skull

0.242
16.62

0.298
16.21

0.362
15.87

0.456
15.46

0.559
15.10

Table of Constitutive Parameters for FDTD Human Head/Shoulders Mesh for various
frequencies.  Material column is the XFDTD mesh material number for that particular
tissue type.   Upper number in each entry is conductivity in Siemens/meter, lower is
relative permittivity. Average values used for muscle, brain and skull.  Based on the
values of Camelia Gabriel, Ph.D., and Sami Gabriel, M. Sc. as described above.
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16-2 The Remcom High-Fidelity Head and Shoulders Mesh

The Remcom High-Fidelity Head and Shoulders mesh is based on the same data as
used in the 3mm mesh, but it uses 2x2x2.5 mm cells and has dimensions 309x177x161
for 8,805,573 cells.   It contains 17 materials which are assigned as follows:

XFDTD #2 Skin
XFDTD #3 Tendon
XFDTD #4 Fat/Yellow Marrow
XFDTD #5 Cortical Bone
XFDTD #6 Cancellous Bone
XFDTD #7 Blood
XFDTD #8 Muscle
XFDTD #9 Grey Matter 
XFDTD #10 White Matter
XFDTD #11 Cerebro-spinal fluid 
XFDTD #12 Sclera/Cornea
XFDTD #13 Vitreous Humor
XFDTD #15 Nerve
XFDTD #16 Cartilage
XFDTD #17 Tongue/Thyroid
XFDTD #19 Cerebellum
XFDTD #20 Esophagus

Measured values for the tissue parameters for a broad frequency range from 1 MHz to
20 Ghz are included with the mesh data.  The tissue parameters may be adjusted
automatically for a specific frequency by using the Edit->Adjust Tissue Material
Parameters menu.  The correct values from the table of measured data will be selected
and entered into the appropriate mesh variables.  The mesh must be saved after
adjusting the parameters for the new values to be used in the XFDTD calculation but
the parameters can be adjusted as many times as required.
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17  The Human Body FDTD Mesh

You may have received one of our FDTD meshes of a male human body.  They were
created using digitized data in the form of transverse color images.  The data is from
the Visible Human Project sponsored by the National Library of Medicine (NLM) and is
available via the Internet at no cost. The male data set consists of MRI, CT and
anatomical images.  Axial MRI images of the head and neck and longitudinal sections
of the rest of the body are available at 4 mm intervals.  The MRI images have 256 pixel
by 256 pixel resolution.  Each pixel has 12 bits of gray tone resolution.  The CT data
consists of axial CT scans of the entire body taken at 1 mm intervals at a resolution of
512 pixels by 512 pixels where each pixel is made up of 12 bits of gray tone.  The axial
anatomical images are 2048 pixels by 1216 pixels where each pixel is defined by 24
bits of color, about 7.5 megabytes.  The anatomical cross sections are also at 1 mm
intervals and coincide with the CT axial images.  There are 1871 cross sections for
each mode, CT and anatomy.  The complete male data set is 15 gigabytes in size.  Our
mesh of the human body required the axial anatomical images since these had the
finest resolution of the entire body.

17-1 The Original 5mm Body Mesh

The choice of the problem space dimensions came from consideration of the computer
resources that would be required to make the calculation.   An FDTD mesh of six million
cells will require about 180 MBytes of RAM and about 6 hours of run time on a fast
work station.  A cell size of 5 mm was chosen since it will allow the entire human body
including a 20 cell border to be modeled in a space of 157x102x396 or 6,341,544 cells.

Creating the XFDTD .id file from the axial anatomical images 

Each of the axial anatomical images contains .33 mm x .33 mm pixels.  We sample
each image every 15 x 15 pixels such that we represent an area 5 mm x 5 mm with one
pixel or 24-bit value.  We convert this 24-bit data value to a corresponding set of
constitutive parameters by assigning tissues to six different tissue types.  Each of these
is also assigned a material type number in XFDTD.  The six groups of tissue types and
their XFDTD material numbers are 

group 1 XFDTD #14 fat, bone, cartilage
group 2 XFDTD #4 intestine, liver, kidney, muscle, spleen, pancreas, skin
group 3 XFDTD #9 nerve, brain
group 4 XFDTD #7 eye
group 5 XFDTD #15 blood
group 6 XFDTD #13 lung

This grouping or conversion process was done by inspection.  Each 24-bit value that
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corresponds to an FDTD cell must be examined with the help of  [19,20] and properly
placed into one of the above six groups.

For each tissue group we have found reasonable approximations to the material density
in kg/m**3, conductivity (sig) in S/m and relative permittivity.  The electrical constitutive
parameters change with frequency, and values for 5 different frequencies are given in
the table:

Constitutive Parameters for FDTD Human Body Mesh

tissue type     density 150 MHZ  300 MHZ  500 MHZ  700 and 915 MHZ 
                kg/m3  sig, eps sig, eps sig, eps sig, eps 

fat, bone        1130    .07, 6.7 .09, 8.3 .07, 5.1 .07, 5.1
cartilage                                       

intestine,        1020    .88, 69  .92 ,57  .85, 56      1.0, 52.6
liver,
kidney,
muscle,
spleen,
pancreas,
skin

nerve, brain    1050     .57, 72  .61, 55  .7, 46            .75, 44   
  
eye                 1000     1.9,84  1.7,74  1.9,70          1.9, 70           
 
blood              1000     1.12, 70 1.19, 74 1.09, 63       1.18, 62         

lung            330     .28, 22  .22, 12  .24, 12        .24, 12           

sig=conductivity in Siemens/m eps=relative permittivity

17-2 The Remcom High-Fidelity Body Mesh

The Remcom High-Fidelity Body mesh is based on the same data as used in the
original mesh.  It uses 5x5x5 mm cells and has dimensions 136x87x397 for 4,697304
cells.   The High-Fidelity mesh is much more detailed than the original mesh and it
contains 23 materials which are assigned as follows:
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XFDTD #2 Skin
XFDTD #3 Tendon, pancreas, prostate, aorta, liver, other
XFDTD #4 Fat/Yellow Marrow
XFDTD #5 Cortical Bone
XFDTD #6 Cancellous Bone
XFDTD #7 Blood
XFDTD #8 Muscle, heart, spleen, colon, tongue
XFDTD #9 Grey Matter, cerebellum
XFDTD #10 White Matter
XFDTD #11 Cerebro-spinal fluid 
XFDTD #12 Sclera/Cornea
XFDTD #13 Vitreous Humor
XFDTD #14 Bladder
XFDTD #15 Nerve
XFDTD #16 Cartilage
XFDTD #18 Gall Bladder bile
XFDTD #19 Thyroid
XFDTD #20 Stomach, Esophagus
XFDTD #21 Lung
XFDTD #22 Kidney
XFDTD #24 Testes
XFDTD #25 Lens
XFDTD #27 Small intestine

Measured values for the tissue parameters for a broad frequency range are included
with the mesh data.  The tissue parameters may be adjusted automatically for a specific
frequency by using the Edit->Adjust Tissue Material Parameters menu.  The correct
values from the table of measured data will be selected and entered into the
appropriate mesh variables.  The mesh must be saved after adjusting the parameters
for the new values to be used in the XFDTD calculation but the parameters can be
adjusted as many times as required.
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18 Output File Formats

The file formats for several of the XFDTD 5.0 data files are provided in this chapter for
users who wish to display the data in some format not provided by XFDTD.  The most
common output files will be discussed here while some files used by XFDTD for internal
processing will be omitted.  The geometry files are discussing in a separate chapter.
All output files have some type of header information which is terminated by the
character string #@.    See the coordinate system figure at the beginning of this manual
for the angular measures.

Near-Zone Data

Example: monboxEZT.x00011.y00020.z00005.g0

Near-zone values are saved at every timestep.  The data file contains two columns: the
time in seconds and the field value in the appropriate units.  

Far-Zone Data

Example: monbox.pafp0t0 or monbox.pvt90.pb0.pe360.in10 or monbox.patp0f1030

There are many possibilities for far-zone data files depending on the far-zone
transformation used and the output data.  The output files will have similar formats
though. 

For transient far-zone files, the choices are gain/RCS vs frequency, theta, or phi and
far-zone electric fields versus time.  
-For the far-zone fields versus time, the format is three columns: time (seconds), phi-
directed electric field (v/m), theta-directed electric field (v/m).    
-For gain/RCS versus frequency, there are five columns: frequency (Hz), phi-directed
gain magnitude (dBi or dBsm), theta-directed gain magnitude (dBi or dBsm), phi-
directed gain phase (degrees), theta-directed gain phase (degrees).
-For gain/RCS versus theta (or phi) there are five columns: theta (or phi) (degrees), phi-
directed gain magnitude (dBi or dBsm), theta-directed gain magnitude (dBi or dBsm),
phi-directed gain phase (degrees), theta-directed gain phase (degrees).

For steady-state far-zone files, the choices are gain/RCS versus theta or phi.  There
are no far-zone time domain fields available with the steady-state far-zone
transformation.
-For gain/RCS versus theta (or phi) there are five columns:  theta (or phi) (degrees),
phi-directed gain magnitude (dBi or dBsm), theta-directed gain magnitude (dBi or
dBsm), phi-directed gain phase (degrees), theta-directed gain phase (degrees).
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S-parameter Data

Example: monbox.s11 or monbox.ss.s11

For transient S-parameter calculations, the file has five columns: frequency (Hz), the
real part, the imaginary part, the magnitude (dB), and the phase (degrees).

For steady-state S-parameters, there is only a single line of data in the same format as
above.

Transient Field Data

Example: monbox.xz12.t200.fld

These are the field snapshot which show the electric and magnetic fields or current
density in a plane at various moments in time.   The file has a header which contains
five lines.  Below is an example with the definitions of each item.

t                          - means the file contains total field data.  This is always the case.
80 1200 3 18 0   - timestep number, maximum timestep number, slice direction (1=xy,
2=yz, 3=xz), the slice number (which is always one less than what is shown in XFDTD),
and the grid number (0=main grid, 1=subgrid 1, etc)
67 37 91             - the dimensions of the space in cells
3.216099e+00    - the timestep in picoseconds
1.670000e-03 1.670000e-03 1.670000e-03    - the spatial increments of the geometry

Following this header, there are 9 floating point numbers for every cell in the space
starting in the lowest corner and working up to the highest.  So, if this is the xz plane,
the first point will be for x=1, z=1.  The loop will be as follows:

from z=1 to maximum z
  From x=1 to maximum x
                          Write -> Ex, Ey, Ez, Hx, Hy, Hz, Jx, Jy, Jz
In the xy plane it will be:

from y=1 to maximum y
  From x=1 to maximum x
                          Write -> Ex, Ey, Ez, Hx, Hy, Hz, Jx, Jy, Jz
In the yz plane it will be:

from z=1 to maximum z
  From y=1 to maximum y
                          Write -> Ex, Ey, Ez, Hx, Hy, Hz, Jx, Jy, Jz
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Steady-State Data

Steady-state data files have the same header as the transient field files.  The SAR and
conduction current files have a different body while the electric field magnitude and
magnetic flux density files have the same format as the transient field files only with
different data.

For the EFM and BFD files, the data written for each cell (following the same loops as
given above for the transient fields) is EFMx, EFMy, EFMz, EFMtotal or BFDx, BFDy,
BFDz, BFDtotal.

For the SAR and Conduction current files, the data only exists in certain cells.  Therefor
the data is only saved for those cells with non-zero values.  After the header there is a
string followed by an integer indicating the number of cells with data.  After this integer
follow the lines containing the cell location and the field values.  

For SAR this might look like:
(header)
array format: material
1640
40 69 30 2.639620e-05 
...(this repeats for 1639 more lines)

In this line,  X=40, Y=69, Z=30, SAR=2.63...  Note that the X,Y,Z values are one less
than what is displayed in XFDTD.  This SAR value would actually appear at cell
41,70,31.

For the Conduction currents the file would look like this:
(header)
array format: material
3
13 10 20 0.000000e+00 1.397751e-01 5.143908e-01
13 11 20 0.000000e+00 0.000000e+00 4.806674e-01        
13 10 21 0.000000e+00 8.427364e-02 0.000000e+00

Here there are only 3 lines.  The first line has data for X=13, Y=10, Z=20, CCMx=0.0,
CCMy=1.397751e-01, and CCMz=5.143908e-01.  Again, the x,y, and z values are one
less than what is displayed in XFDTD.
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